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 multi-screen display technology. It 
mage with digital imagery, video 
omputer technology. Use it with 
ook it up to monitors, video wall 
screen arrangements.

  

rts:

n, giving you the big picture. Start 
 your first look at WATCHOUT.

ows, menus, commands and other 
re about specific functions

l information related to particular 
 inputs and external control proto-

   

rsion of this manual, the table of 
 can be clicked to jump directly to 

  

3. The latest version of the software 
ined from:
Chapter 1     Introduction

1 INTRODUCTION

WELCOME Welcome to WATCHOUT™, a fully digital,
combines the qualities of traditional multi-i
and the graphics power of contemporary c
projectors for large, seamless images, or h
cubes or plasma screens for other creative 

About This Manual This manual is divided into the following pa

• A Quick Start and an Introduction sectio
here if you’re a new user or just having

• A reference section, describing all wind
details. Refer to this section to learn mo

• A number of appendices with additiona
areas of the product, such as live video
cols.

◆ HINT: If you’re reading the electronic ve
contents, index and all cross references
the referenced page.

WATCHOUT Version 3 This manual refers to WATCHOUT version 
and its documentation can always be obta

http://www.dataton.com/watchout/

Just Getting Started?

To get up to speed with 
WATCHOUT as fast as 
possible, go straight to 
“Quick Start” on page 14.

http://www.dataton.com/watchout/


   

 parts that make up a 
r.

  

duction work. This is where you 
te your presentation. Using the 

3), you simply drag media into 
indow and along the Timeline.

y Display
4

Projectors

Display
computers
8 Chapter 1     Introduction

SYSTEM OVERVIEW This section provides a brief introduction to the
WATCHOUT system, and how they fit togethe

Production Computer This is the focal point for your WATCHOUT pro
collect all the source material, or media, to crea
WATCHOUT production software (see page 1
your presentation, positioning it in the Stage w

Display
2

Display 1

Displa
3

• Safety
• Speed
• Tires!

Main image
area using

overlapped
projectors

Separate
plasma
display

Ethernet Network

Production
computer
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y computers through the network, 
 as well as controlling the playback 

  

isplay device (projector, monitor, 
uters handle all the hard work 
ideo. They also apply edge blends 

 display device makes the system 
ays are added, you also add more 

  

g the production computer to 
k is created by connecting the 
 shown in the overview illustration).

n, or revise existing media, these 
 the network, to the appropriate 
ers your display configurations, 
f your presentation to the display 
 the display computers, very little 

ork during playback, avoiding 

  

y display device that can be 
s, LCD and plasma displays. See 
ails.
Chapter 1     Introduction

The production computer talks to the displa
transferring media files for you as required,
of the show. 

Display Computers You need one display computer for each d
etc) used in you presentation. Display comp
associated with rendering still images and v
and play sound files.

The fact that there’s one computer for each
scalable to virtually any size; as more displ
computing power to drive these displays.

Network The network ties the parts together, allowin
manage all display computers. The networ
computers to a common hub or switch (not

As you add new media to your presentatio
changes are automatically propagated, via
display computers. The network also transf
timeline programming and other aspects o
computer. With all this material residing on
information needs to be sent over the netw
network congestion.

Display Devices WATCHOUT can be used with virtually an
connected to a computer, such as projector
“Display Issues” on page 169 for more det



   

oduction software on its own in 
appreciate the full power of 
omputers. The illustration to the 
ollowing components:

on software.

software

r a projector).

ogether via a hub or switch.

g WATCHOUT must have a 
se Keys” on page 32).

   

d on its own without a license 
sing the display software.

  

ou arrange the displays. The 
play arrangements. In addition, 
d surfaces (see “Geometry 

Arch built using
multiple LCD displays
10 Chapter 1     Introduction

Minimal System Configuration Although you can use just the WATCHOUT pr
order to get acquainted, you won’t be able to 
WATCHOUT until you connect some display c
left shows a minimal system, consisting of the f

• A computer running WATCHOUT Producti

• A computer running WATCHOUT Display 

• A display device (for example, a monitor o

• A network, connecting the two computers t

In addition, each computer in a system runnin
WATCHOUT license key connected (see “Licen

◆ NOTE: The production software can be use
key. License keys are only required when u

Alternative Display Layouts WATCHOUT is very flexible in terms of how y
illustrations below show some more unusual dis
WATCHOUT also supports projection on curve
Correction” on page 136).

Display

Hub

Production
computer

Display
computer

Plasma display
column

Vertically oriented, edge
blended projectors

Diamond-shaped
display cluster
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media, such as still images, video 
 a wide variety of file formats, 
F, Targa, AVI, QuickTime, MPEG-

2 and Windows Media), AIFF and 
eas (alpha channel) are supported 
ing on chosen file formats).

ia supported by WATCHOUT, see 

  

HOUT can also incorporate live 

e image of a speaker into the 

ayer or a satellite link.

presentations.

re, such as capture cards, in order 
Live Video” on page 61). In other 
o the system through the network.

  

ystems and technologies to build 
taton TOUCHDOWN

 

TM

 

 as an inter-
WATCHOUT clusters. Use Dataton 

  

o provide synchronized, multi-
o WATCHOUT over a computer 
 appendices for details on external 
Chapter 1     Introduction

Images, Sound and Video A WATCHOUT presentation uses multiple 
clips, sound files, etc. WATCHOUT accepts
including PhotoShop, JPEG, BMP, PNG, TIF
1, MPEG-2, High Definition Video (MPEG-
WAV. Transparent and semi-transparent ar
in both still images and video files (depend

For more details on the various kinds of med
“Media” on page 47.

Live Feeds In addition to pre-produced content, WATC
feeds of various kinds:

• Video camera, e.g., for integrating a liv
presentation.

• Other external feeds, such as a DVD pl

• Computer graphics, e.g., a PowerPoint 

Some live feeds require additional hardwa
to bring the signal into WATCHOUT (see “
cases, the external feed can be brought int

External Control WATCHOUT can be combined with other s
entire presentation environments. Use a Da
active front-end, controlling any number of 
PICKUPTM as a simple remote control and t
lingual audio. Or make other systems talk t
network, serial port or a timecode feed (see
control options).Dataton TOUCHDOWN, PICKUP.



   

HOUT production software.

  

isplays (screen areas) to reflect 
eview of the end result, and 
ovement of images.

  

to the Timeline window, where 
bnail icon of the media. You 
e position and length of these 
ow represent the order of over-

  

e media files also appear in the 
ry for all media used in your 
h media file, and allows the file 
oses.

  

ced by applying tween tracks. 
media on stage, such as posi-

  

e changes can be transferred to 
. This automatically transfers 
e relevant display computers 
les and cues are cached locally 
o run at any time by simply 
12 Chapter 1     Introduction

SOFTWARE OVERVIEW This section gives an introduction to the WATC

Stage Window The Stage window allows you to organize the d
their expected placement. It also provides a pr
allows you to manipulate the placement and m

Timeline Media files are dragged from your hard disk in
they appear as cues. Each cue features a thum
determine timing and duration by adjusting th
cues. The horizontal layers in the Timeline wind
lapping images, back-to-front.

Media As media is added, thumbnails representing th
Media window. This acts as a central reposito
presentation. It provides information about eac
to be easily accessed for editing or other purp

Cues and Tween Tracks The cues in the Timeline window can be enhan
Tween tracks control the dynamic behavior of 
tion, size or transparency.

System Management As you make changes to the presentation, thos
all the display computers by a single keystroke
any media you have added, or modified, to th
and shows the result on screen. As the media fi
on each display computer, the show is ready t
pressing the spacebar.
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 speed on WATCHOUT as 
tart running the WATCHOUT 
g and editing a full-blown 
 have the WATCHOUT DVD-
appendix A).

  

e WATCHOUT Installer found 
tructions to install WATCHOUT 
M also installs other required 

   

nown incompatibilities with 
e on your computer, you may 

ng WATCHOUT, thereby 
commended version.

  

” from the WATCHOUT DVD-
 hard disk. Alternatively, if you 
pack the archive file.

   

tion from its folder on the DVD-
 hard disk.

  

his is inside the folder that you 
Double-click this file to open it 

HOUT examines and caches 
This happens only once.
14 Chapter 1     Introduction

QUICK START This section is designed to get new users up to
quickly as possible. Follow the instructions to s
production software on your computer, playin
WATCHOUT presentation. It assumes that you
ROM and a modern Windows computer (see 

Install the Software If you haven’t already done so, double-click th
on this DVD-ROM and follow the on-screen ins
on your computer. The installer on the DVD-RO
components, such as QuickTime.

◆ NOTE: Some versions of QuickTime have k
WATCHOUT. If you already have QuickTim
want to un-install QuickTime before installi
allowing the automatic installation of the re

Copy the Demo Show Drag the folder titled “Demo Show and Media
ROM to a suitable location on your computer’s
obtained the demo show from our web site, un

◆ NOTE: It is not possible to open the presenta
ROM. You must copy it to your computer’s

Open the Show Locate the file named “WATCHOUT Demo.” T
copied to your hard disk in the previous step. 
using the WATCHOUT production software.

When opening a show for the first time, WATC
media files, as indicated by the progress bar. 
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s shown on the previous page. 
e you have sound playback 
hing the show in its entirety, you 
eyboard to review any section, 
page.

 is designed to play using three 
window on your computer 
ing it full-scale on a big screen, 
TCHOUT show is put together.

   

 demo show – such as those 
uire a more powerful computer 
ications in Appendix A.

  

 the demo show. Move things 
ns and edit the parameters of 
r details.

  

le presentations, you need to 
ther display devices) as shown 

ng up and configuring a 

es, you also need to acquire 
n page 32). To run a show like 
 WATCHOUT Starter Kit 
license keys. You would use one 
 display computer.
16 Chapter 1     Introduction

Watch the Show The show should now appear on your screen, a
Press the space bar to run the show. Make sur
enabled, so you can hear the audio. After watc
can use the Function keys on your computer’s k
as indicated in the illustration on the previous 

As you can see in the Stage window, this show
overlapped projectors. Watching it in a small 
doesn’t come anywhere near the impact of view
but should still give you an idea of how a WA

◆ NOTE: For best effect, some sections of the
involving high definition video – would req
than is stated in the minimum system specif

Change the Show To get familiar with WATCHOUT try modifying
around, replace graphics, change cue duratio
cues. Please refer to Chapter 4 “Production” fo

Where to Go From Here To use WATCHOUT for running actual, full-sca
hook up display computers and projectors (or o
on page 8. Chapter 2 provides details on setti
complete system.

In addition to the computers and display devic
WATCHOUT license keys (see “License Keys” o
the demo in this section, you could start with a
(product number 3154-1), which includes four 
for the production computer and one for each

WATCHOUT Starter Kit.
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WATCHOUT
SUCCESS STORIE
THE FOLLOWING PAGES PRESENT SOME REAL-WORLD CASE STUDIES, INTENDED
SPIRATION FOR YOUR OWN FUTURE PROJECTS. AS YOU WILL SEE, WATCHOUT IS
FLEXIBLE PRODUCT, THAT CAN BE USED IN WIDE VARIETY OF APPLICATIONS
YOU’VE BECOME FAMILAR WITH WATCHOUT, YOU’LL FIND THAT YOU END UP U
FOR ALL KINDS OF THINGS – WHENEVER AND WHEREVER YOU NEED TO SHOW
LOOKING IMAGES. WHEN YOU DO, PLEASE LET US KNOW!
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A stunning 18-screen 
multimedia production 
entitled “Global Sym-
phony” now adorns the 

ous, atrium-style, 
ce to the Global 
unications Center 
CDC (Centers for 
e Control and 
tion) in Atlanta, 
ia. 
n WATCHOUT, 
ding multi-display 
tation system, 

sed to create the 
cular show at the 

 WATCHOUT MANU WATCHOUT MANU 5/5/06   11:15:13 AM5/5/06   11:15:13 AM
enorm
entran
Comm
at the 
Diseas
Preven
Georg
Datato
the lea
presen
was u
specta
CDC.
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NINTENDO
WORLD

A TWO-STORY CASCADE 
of visual excitement 
illuminates the lobby of 
Nintendo World at the 
Rockefeller Center in New 
York City.
Nine rear projection 

reens arranged as 
ee triangles stacked 
rtically create a swirl 
 animated content that 
bbles up  through the 
iling, enticing visitors to 
 upper level.
ur big plasmas in the 
nt windows of the 
ming paradise play 
fast-paced attention 
abber put together and 
ogrammed in Dataton 
ATCHOUT™.

 WATCHOUT MANU WATCHOUT MANU 5/5/06   11:15:16 AM5/5/06   11:15:16 AM
sc
thr
ve
of
bu
ce
the
Fo
fro
ga
a 
gr
pr
W
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GES COURTESY OF DOUGLAS MESNEY, 
INCREDIBLE IMAGES.

 WATCHOUT MANU WATCHOUT MANU 5/5/06   11:15:22 AM5/5/06   11:15:22 AM
IMA
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With a prime location on
e new Culture
come a favori
ans. The cente
 original conc
, lounge and b
ATCHOUT. Cu
is a Heineken

IMAGES COU

CULTURE BIÉR

 WATCHOUT MANU WATCHOUT MANU 5/5/06   11:15:32 AM5/5/06   11:15:32 AM
Elysees, th
rapidly be
and Parisi
three-floor
restaurant
Dataton W
2005 and 

RTESY OF VIDEMUS, PARIS.
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n on the
ture Bièr
vorite am
enter is a
oncept i
nd bar, a
. Culture
ken Fran

Dataton WATCHOUT is 
used in both the bar and 
the shop area at Cul-
ture Bière. Paris-based 

emus stands for the 
ltimedia and audiovi-
l design. 
e ground fl oor shop 
tures six plasma 
eens vertically set, 
h an artistic anima-
 of  growing hops,” 
lains Eric Lambert, 
emus. “The bar is 
 of the longest in 
is and backed by 
r 20 meters of video 

eens. This is also a 
TCHOUT show.
 system can also 
play live events like 
cer match or F1 race, 
g WATCHOUT as 
kground for  multi-

ture display.

ÉRE, PARIS

 WATCHOUT MANU WATCHOUT MANU 5/5/06   11:15:34 AM5/5/06   11:15:34 AM
 Champs
e center has 
ong tourists 
 1200 m2, 

ncluding a shop, 
nd featuring 
 Bière opened in 
ce development.

Vid
mu
sua
“Th
fea
scr
wit
tion
exp
Vid
one
Par
ove
scr
WA
The
dis
soc
usin
bac
pic
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THIS rs and one produc-
tion c x 480 pixel resolu-
tion e agic in Singapore 
with 

S L
TO

IMAGES
MEDIASE

 WATCHOUT MANU WATCHOUT MANU 5/5/06   11:15:35 AM5/5/06   11:15:35 AM
PROMOTIONAL EVENT took place in Berlin, Germany. It featured 32 display compute
omputer. The show ran on two mirrored plasma screen walls with 32 screens in 848 
ach. A truly international project, the WATCHOUT  show was programmed by Digim

Mediaservice Beddig, Germany, responsible for the setup.

TB/INTERNATIONA
URISM BORSE

 COURTESY OF RAINER BEDDIG, 
RVICE.
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WITH JUST TWO weeks for production, Simon Exton at Ray-Gun pulled out all the stops and created a fabulous 
360 degree show with WATCHOUT. The immersive experience was a feel-good event for Chevrolet in Dubai 
and ran for four nights, eight hours at a time. Thousands of visitors enjoyed the thrill of vehicles driving the full 
360 degrees around the WATCHOUT screens.

LET
EES

ES COURTESY OF SIMON EXTON, 
RAY-GUN

 WATCHOUT MANU WATCHOUT MANU 5/5/06   11:15:47 AM5/5/06   11:15:47 AM
CHEVRO
360° DEGR

IMAG
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t of world culture in a 
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 WATCHOUT MANU WATCHOUT MANU 5/5/06   11:15:48 AM5/5/06   11:15:48 AM
USEUM OF WORLD CULTURE opened its doors in  
org, Sweden, on December 29, 2004. The museum 

es on themes that refl ects the breadth, depth, variety 
ynamism inherent to the concept of world culture. 
useum is one of the largest permanent installations 

ataton WATCHOUT. Local dealer, Primetec, used 
ATCHOUT licenses, distributed across the

three fl oor exhibition. WATCHO
create seamless panorama image
areas designed to work in sync
other events.
The museum interprets the concep
dynamic and open-ended manne
WATCHOUT just fi ne.

ORLD
ULTURE

 COURTESY OF THE MUSEUM OF WORLD CULTURE
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 WATCHOUT MANU WATCHOUT MANU 5/5/06   11:16:10 AM5/5/06   11:16:10 AM
PENING
TIVE TECHNOLOGY UK was contracted 
ck Morton Worldwide to provide the 
 solution for the spectacular Opening 
ony of the 2004 Olympics in Athens. 
 with an enormous technical and physi-
allenge, CT chose the Dataton WA-
UT™ multi-display presentation system.

on WATCHOUT  was used to project 
 meter high images on fl oating rocks 
 estimated four billion viewers. “The 

es looked stunning, both in the stadium 
n TV,” says Charlie Whittock, CT’s 
ging director.

 COURTESY OF CREATIVE TECHNOLOGY UK
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THE ANN
Brazil is 
importan
The 200
WATCH
larger th
was sup
AV provi
At this ye
three hug
high, ass
main ent
panoram

, 36 in all. The panels 
 illustrations, computer 
ts, paintings and high 
. The entire display 
t2) and ran for a total 

ed by a nine-camera 
the room to follow, in 
ement of the models.

MAGES COURTESY OF ON PROJECOES, 
BRAZIL

 WATCHOUT MANU WATCHOUT MANU 5/5/06   11:16:21 AM5/5/06   11:16:21 AM
UAL SÃO PAULO Fashion Week, in Sao Paulo, 
a week-long event billed as Latin America’s most 
t fashion happening.
5 edition of the fashion week teamed Dataton 
OUT with 36 Christie LCD projectors to create a 
an life backdrop. The dramatic display solution 
plied by On Projecoes, one of Brazil’s leading 
ders.
ar’s event, the main scenario was composed of 
e screens, each 40m (131ft) wide by 7m (23ft) 
embled in zig-zag panels spanning the foyer and 
rance areas. Daily from 9:00am to 11:00pm, 
ic images were projected onto these screens 

from Christie LX41 LCD projectors
displayed a mix of digital videos,
generated animations, graphic ar
resolution images of Brazilian life
covered almost 1,000m2 (7,534f
of 98 hours.
Live “catwalk” shows were captur
array allowing the public outside 
detail and in real-time, every mov

I

AL CASE-STUDIES.in13   13AL CASE-STUDIES.in13   13



…
FOR EVEN MORE CASE STUDIES, CHECK OUT THE “SUCCESS STORIES” SECTION AT 
HTTP://WWW.DATATON.COM

 WATCHOUT MANU WATCHOUT MANU 5/5/06   11:16:24 AM5/5/06   11:16:24 AM
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2

 

uired software components as well 

  

from the WATCHOUT CD-ROM or 

nstructions. This installs both the 
ts, adding them to your Start menu.

   

r primarily for WATCHOUT, first 
uter” on page 155.

  

OUT CD-ROM, QuickTime is 
WATCHOUT from the web, Quick-

  

to obtain it from

l?artnum=120297  (recommended)

nload/standalone.html  (latest)

   

nded version (QuickTime 6.4), 
tallation mode, then click “Select 
Chapter 2     Installation

2 INSTALLATION

This chapter tells you how to install the req
as how to hook up the hardware.

SOFTWARE Obtain the “WATCHOUT Installer”, either 
by downloading it from

http://www.dataton.com/watchout/

Run the installer and follow the on-screen i
production and display software componen

◆ NOTE: If you intend to use the compute
read the section titled “Dedicated Comp

Installing QuickTime If you install WATCHOUT from the WATCH
installed automatically. If you downloaded 
Time is not included. In this case you need 

http://docs.info.apple.com/article.htm

http://www.apple.com/quicktime/dow

▲ IMPORTANT: If you install the recomme
make sure you choose the “Custom” ins
All” to install all components.

http://www.dataton.com/watchout/
http://www.apple.com/quicktime/download/standalone.html
http://docs.info.apple.com/article.html?artnum=120297


   

uters must be interconnected 
hich comes standard on most 
mended, Gigabit and 10 MBit 

rally not recommended.

  

ed number of ports. Most hubs 
.

stem, this is usually all you need 

  

OUT license key, including the 
 USB (Universal Serial Bus) port 

   

e off-line without a license key 
go on-line to communicate with 

 hub or switch

Display
Computers
32 Chapter 2     Installation

NETWORK The production computer and all display comp
using a TCP/IP compatible Ethernet network, w
computers. Although 100 MBit Ethernet is recom
can also be used. Wireless networks are gene

Stand-alone System Connect all computers to a hub with the requir
have indicators that identify proper connection

For stand-alone operation of a WATCHOUT sy
to do in terms of hardware hook-up.

LICENSE KEYS Each computer in the system requires a WATCH
production computer. Plug the key into any free
on the computer.

◆ NOTE: You can run the production softwar
connected. A key is only needed when you 
the display computers.

Ethernet

Production
Computer
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eleased (for example, going from 
 must be upgraded in order to be 
grade can be purchased and deliv-
grading your Licenses” on 

  

y technologies, including CRT, DLP 
, video wall cubes and plasma 
ny display device that’s compatible 
er. 

h a high contrast ratio (2000:1 or 
s” on page 169 for further details 
nnect them to WATCHOUT.

  

s, it is important to choose the 
u buy your screen material from a 
rements of multi-image projection, 

, or “silver” screens. Such screens 
hen using multiple projectors and/

 See “Banding” on page 175.

on screens is the “hot-spot” caused 
 projection surface. See “Rear 
Chapter 2     Installation

Upgrading License Keys When a major revision of WATCHOUT is r
version 2.x to version 3.x), old license keys
used with that new software version. An up
ered electronically via the Internet. See “Up
page 100 for more details.

DISPLAY DEVICES WATCHOUT can be used with most displa
and LCD projectors, LCD and CRT monitors
screens. Generally speaking, you can use a
with the display card in the display comput

For projection purposes, DLP projectors wit
better) is recommended. See “Display Issue
on various kinds of displays, and how to co

PROJECTION SCREEN As in all multi-screen projection application
screen material with caution. Make sure yo
screen manufacturer familiar with the requi
or similar applications.

For front projection, avoid using high-gain
often cause uneven brightness or banding w
or when viewing from non-optimal angles.

A related problem when using rear projecti
by the projection lens showing through the
Projection” on page 176.



   

lay computers. Simply connect 
3.5 mm mini-jack) to the ampli-

io signal a long distance, you 
 converts the unbalanced signal 
l, thereby reducing the risk of 

nal audio amplifier.

  

ing at the same time, thereby 
nization between computers is 
port or special effects sound 
hannel sound reproduction.

nd card in a display computer. 
e accurate sound channels. See 
etails.

  

ng video input devices, such as 
atellite link or the image 
 Microsoft PowerPoint

 

®

 

 presen-
nput solutions, see “Live Video 

  

 where it’s supposed to appear. 
mputers, and you want to show 
 display areas, both those 
 kind of capture card, and the 
both cards. 
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SOUND Sound can be provided through any of the disp
the sound output from the computer (usually a 
fier or powered speakers.

If you need to run the computer’s line level aud
should use an audio line level transformer. This
coming from the computer to a balanced signa
hum and noise when connected to a professio

Using Multiple Sound Channels You can have multiple display computers play
providing multiple audio channels. The synchro
generally good enough for multi-language sup
tracks, but not for true, phase accurate, multi-c

Another option is to install a multi-channel sou
Such sounds cards can handle up to eight phas
“Multi-Channel Audio” on page 59 for more d

LIVE VIDEO INPUT WATCHOUT can integrate live video feeds usi
capture cards. This may be a camera feed, a s
displayed by another computer (for example, a
tation). For examples on some suitable video i
Input” on page 153.

Feeding Multiple Display Computers The video signal must be fed to each computer
For instance, if your system uses five display co
a live video image straddling two of those five
display computers must be fitted with the same
video signal must be fed to the same input on 

Sound output jack symbols.
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 required to distribute the signal to 
rom companies such as Extron and 

  

tware drivers. Although such a 
a CD-ROM, it’s often a good idea 
 latest driver version. For a list of 

ut” on page 153.

nputs have additional drivers that 
ate the capture function. Please see 
commended procedure, since the 

 sometimes important.

  

uter that will show live video as 
 125. Optionally, you can also 

ow of the production computer (see 
Chapter 2     Installation

A video DA (distribution amplifier) may be
multiple inputs. Such devices are available f
Kramer Electronics:

http://www.kramer.co.il/

http://www.extron.com/

Software Driver Installation Most capture cards require specialized sof
driver is usually delivered with the card on 
to check the manufacturer’s web site for the
suitable capture cards, see “Live Video Inp

Some graphics cards that include capture i
must be installed separately in order to activ
the manufacturer’s documentation on the re
order in which these drivers are installed is

WATCHOUT Configuration Configure each WATCHOUT display comp
described under “Add Live Video” on page
choose to show live video in the Stage wind
“Video In” on page 111).

http://www.extron.com/
http://www.extron.com/


   

 WATCHOUT to integrate a live 
ample, to display Excel or 
ntation), you must install VNC 
ust be a separate computer – it 
CHOUT software. 

   

ic WATCHOUT functions. You 
t to use the “Remote Computer” 
age 123).

are is available for a wide 
elow describe its installation 

ble in several forms:

of the above locations, and 
der Window XP, you’re advised 
 Windows Service.

mputer to run the VNC server 
porate into your presentation 

ed to the WATCHOUT network, 
P settings (see page 40). This IP 
tch the network to which it is 
ed, or that the VNC port 5900 
on page 41).
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VNC SERVER SOFTWARE In order to use the Remote Computer feature of
computer display into your presentation (for ex
Powerpoint as part of a speaker-support prese
server software on the remote computer. This m
can not be one of the computers running WAT

◆ NOTE: This software is not required for bas
only need to install this software if you wan
feature (see “Add Remote Computer” on p

VNC (Virtual Network Computing) server softw
variety of operating systems. The instructions b
under Windows. VNC is free software, availa

http://www.realvnc.com/ 

http://ultravnc.sourceforge.net/

Download the VNC server software from one 
follow its installation instructions. When run un
to install and run the VNC server software as a

For best performance, use a reasonably fast co
software and the application you wish to incor
(for example, Powerpoint). 

Make sure that the remote computer is connect
and has a fixed, known IP number in its TCP/I
number and other TCP/IP parameters must ma
connected. Also verify that its firewall is disabl
is open in the firewall (see “Firewall Settings” 

http://www.realvnc.com/
http://ultravnc.sourceforge.net/
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are, you will be prompted to enter 
 appears as an icon in the lower 
inting at this icon displays the IP 
 icon to change the settings.
Chapter 2     Installation

The first time you run the VNC server softw
a password. The VNC server software then
right corner of the screen while running. Po
number of the VNC server. Double-click the

VNC Server software settings.

Enter the desired VNC server 
password here.



   

/IP networking. Click the Start 
etwork Connections control 
ction” shown in the list. If not, 
etwork card installed in the 
38 Chapter 2     Installation

COMPUTER SETTINGS Each computer needs to be configured for TCP
button and choose Control Panel. Open the N
panel. Make sure there’s a “Local Area Conne
make sure there’s a Windows XP compatible n
computer.
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d choose “Properties”. Ensure that 
d selected.
Chapter 2     Installation

Right-click the “Local Area Connection” an
“Internet Protocol (TCP/IP)” is available an



  

Properties…”. Enter the 
40 Chapter 2     Installation

Choose “Internet Protocol (TCP/IP)” and click “
numbers as shown below.

◆ NOTE: The example shown is 
appropriate if you’re building a 
stand-alone system. If your 
WATCHOUT subnet is connected 
to a larger network, you should 
consult your network adminis-
trator for the correct IP number 
and subnet mask.
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own on page 39), click the 
tton under Windows Firewall. and 
d off. 
Chapter 2     Installation

Firewall Settings Back in the previous dialog box (the one sh
“Advanced” tab and then the “Settings” bu
make sure that the Firewall feature is turne

▲ IMPORTANT: A WATCHOUT sys-
tem should not be accessible from 
the Internet, or other external net-
work. If you must be able to access 
the Internet from your 
WATCHOUT system, use a sepa-
rate firewall device to protect your 
system from security attacks.

The firewall feature must be turned 
off to not interfere with the ability to 
connect to and download media 
files to the display computers.



   

 your WATCHOUT system, you 
lay computers. Most of the 
utton and choosing Settings > 

  

e TCP/IP as described on 
for each display computer by 

roduction computer and three 
ddresses assigned like this:

but connected to a larger 
inistrator for the correct IP 

   

be manually assigned a unique 
, the display computers may not 

ent.

Display
computers

8.0.11
192.168.0.12
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DISPLAY COMPUTER SETTINGS To achieve best performance and reliability in
need to adjust several settings on all your disp
settings below are found by clicking the Start b
Control Panel.

Network Open the Network control panel and configur
preceding pages. Specify a unique IP number 
changing the last group of IP address digits.

As an example: in a system consisting of one p
display computers, you would end up with IP a

If your WATCHOUT subnet is not stand-alone 
network, you should consult your network adm
number, subnet mask, and other parameters.

▲ IMPORTANT: Each display computer must 
IP address. Unlike the production computer
use automatic (dynamic) IP number assignm

192.168.0.1

Production
computer

192.168.0.10
192.16
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our presentation using the “Screen 

lick Apply. 

k the Monitor tab. 

ltiple of the “Display Framerate” 
of your WATCHOUT presentation 
Chapter 2     Installation

Display Properties • Open the Display control panel. 

• Click the Settings tab. 

• Choose the display resolution matching y
area” slider. 

• Set “Colors” to “Highest (32 bit)” and c

• Click the “Advanced...” button and Clic

• Set “Screen refresh rate” to an even mu
specified in the Preferences dialog box 
(see page 108), and click Apply.



  

 mixed PAL and NTSC video, 
es dialog box, and set the 

 

lays work better at 60 fps than 
L video. If you experience jerky 
ant to try setting both the 
 computers to 60 fps/Hertz.

 change the refresh rate. In this 
 under the Adapter tab. This 
ay card drivers and the display 
Rate Settings” on page 165 for 

pt to set the display resolution 
ly is usually preferable. The rea-
w WATCHOUT to set the most 
g the display resolution and re-
ATCHOUT, you avoid the risk 

.
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If you don’t intend to use video, or if you have
choose “60 fps” in the WATCHOUT Preferenc
display’s refresh frequency to 60 Hz.

◆ NOTE: Some video projectors and LCD disp
other refresh rates even when displaying PA
motion and/or video playback, you may w
WATCHOUT Preferences and your display

Some system configurations don’t allow you to
case, the Refresh rate option will not be shown
may vary depending on the display card, displ
connected to the system. See “Display Refresh 
more information.

▲ IMPORTANT: While WATCHOUT will attem
automatically, setting the resolution manual
son is that many display adapters don’t allo
optimal display refresh frequency. By settin
fresh frequency manually before starting W
of getting a non-optimal display frequency
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playback, you should ensure that 
t to its maximum value. Open the 
and slide the volume control all the 
Chapter 2     Installation

Sound Settings When using a display computer for sound 
the sound output level of the computer is se
“Sound and Audio Devices” control panel, 
way to the right.



46 Chapter 2     Installation
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3

not include any media creation or 
our presentation must be supplied 

edia and file formats supported by 
lar applications used to create or 

s in a folder that is located in the 
ile, or in a sub-folder. This allows 
aths, making it easier to move the 
Chapter 3     Media

3 MEDIA

WATCHOUT is a compositing tool; it does 
editing functions. All media to be used in y
and edited using other means.

This chapter provides an overview of the m
WATCHOUT, as well as examples of popu
edit such media files.

▲ IMPORTANT: Keep a show’s media file
same folder as the WATCHOUT show f
the software to use relative file access p
show to another disk or computer.

Various kinds of media in the 
WATCHOUT Media window.



perimposed on other images. 
ling, mirroring and rotation for 

ts, including BMP, GIF, JPEG, 

application used to create/edit 
 to edit images, save the images 
 applications support saving or 

ause a loss of information. This 

ages with WATCHOUT, files 
mpatibility” enabled. This Pho-
ile Handling, File Compatibility.

d or shot using a digital 
rovides the best compromise 
ind that JPEG is a lossy 
rmally unnoticeable, details in 

sion process.

ooth areas (for example, 
format.

 image files into WATCHOUT. 
 be added. A complete list of 
n be found under Apple’s 
om/quicktime/resources/
48 Chapter 3     Media

STILL IMAGES Still images can be used as backgrounds or su
You can control the degree of transparency, sca
all images (stills as well as moving images).

Supported Formats WATCHOUT reads most popular image forma
Photoshop, PICT, PNG, Targa and TIFF. 

Preferably, use an image format native to the 
the images. For example, if you use Photoshop
as Photoshop files. Although most image editing
exporting to other file formats, doing so may c
can make it difficult to edit the image later.

▲ IMPORTANT: In order to use Photoshop im
must be saved with “Maximize PSD File Co
toshop option is found under Preferences, F

For photographic images (for example, scanne
camera), JPEG at a high quality setting often p
between image quality and file size. Keep in m
compression format. This means that minor, no
the original image may be lost in the compres

For computer-generated images with large, sm
screenshots), PNG is a suitable cross-platform 

Apple’s QuickTime technology is used to read
As QuickTime evolves, additional formats may
image file formats supported by QuickTime ca
QuickTime support page: http://www.apple.c

http://www.apple.com/quicktime/resources/
http://www.apple.com/quicktime/resources/


49

nformation in addition to the image 
etimes referred to as an “alpha 
plications use this term for other 
te non-square images, holes inside 
drop shadows. Photoshop, PNG, 
mats that support transparency. 

ts writing to a particular file format, 
ormat. Perform tests with images to 
rmats and applications.

for encoding transparency into 
termined automatically. If not, you 
pecifications dialog box for the 
(see “Transparency” on page 122).

hen composited in 
HOUT.
Chapter 3     Media

Transparency Some image formats include transparency i
itself. This transparency information is som
channel”, although some image editing ap
functions. Transparency can be used to crea
images or semi-transparent areas, such as 
TIFF and Targa file are examples of file for

▲ CAUTION: Even if an application suppor
it may not support transparency in that f
determine the suitability of particular fo

WATCHOUT supports most methods used 
images. Which method to use is usually de
can specify this manually by opening the S
image and choosing the desired encoding 

+ =

Background image. Image with a transparent back-
ground and a semi-transparent 
shadow.

Result w
WATC



other applications, such as 
nctions, such as multiple fonts, 
s effects that can be applied to 

tion computer, you can edit the 
e Media window. Save the text 

menu
50 Chapter 3     Media

TEXT Text, like other images, must be created using 
Adobe Photoshop. In addition to text editing fu
kerning, etc, Photoshop also supports numerou
the text, with the text remaining fully editable.

Assuming Photoshop is installed on the produc
text by simply double-clicking its thumbnail in th
then choose Refresh on WATCHOUT’s Media 

Creating text using Adobe 
Photoshop.

Applying Layer Effects such as glow 
and drop shadow.
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is important that the application 
arency. It must also be able to 
le amount of transparency, often 
ne properly, the edges of the text 
contour or halo around the text.

eos saved in a Windows Media 
at, including MOV, WMV, AVI, 

 (a resolution of 1280 x 720 or 
s Media 9 format. To play back 
 Player 9 or later must be installed 
d from Microsoft).

a video can be encoded by, for 

rocoder2/pm_procoder2.asp

ed using the free Windows Media 

indowsmedia/default.aspx

uires a fast computer (a 3 GHz 
ontent will play on less powerful 

n content, a progressive (that is, 
ample, “30p”).
Chapter 3     Media

Anti-aliasing of Text When overlaying texts on other images, it 
used to save the text image supports transp
render the edges of the text using a variab
referred to as anti-aliasing. If that is not do
will appear jagged, or there will be a thin 

MOVING IMAGES WATCHOUT can play back movies and vid
(DirectShow) or QuickTime-compatible form
DV and MPEG-1/2.

High Definition Video WATCHOUT supports high definition video
more) using either MPEG-2 or the Window
Windows Media 9 video, Windows Media
on each display computer (a free downloa

High definition MPEG-2 or Windows Medi
example, the Canopus ProCoder:

http://www.canopus.us/us/products/p

Windows Media content can also be encod
Encoder 9:

http://www.microsoft.com/windows/w

◆ NOTE: Windows Media HD content req
Pentium 4 or equivalent). MPEG-2 HD c
computers.

When shooting and encoding high definitio
non-interlaced) format is preferable (for ex

http://www.canopus.us/us/products/procoder2/pm_procoder2.asp
http://www.microsoft.com/windows/windowsmedia/technologies.aspx


es, you must specify the frame 
g rendering. Generally, when 

ded video material, the frame 
ly, if your playback computer is 
the WATCHOUT display frame-
or example, 60 fps progressive.

er generated, moving images 
ring only the parts of an image 
rden on the playback machine, 
ind that you can make non-
 using transparency options in 

esolution independent, it is also 
han a single display area. Very 
to be used in WATCHOUT (see 
ending on the performance of 
52 Chapter 3     Media

Computer-generated Animations When using computer-generated moving imag
rate and resolution of the resulting movie durin
combining computer generated and pre-recor
rate is dictated by the live material. Alternative
fast enough, match the rendered frame rate to 
rate (see “Display Framerate” on page 108); f

It’s often advantageous to use smaller, comput
layered on top of larger still images. By rende
that actually move, not only do you lower the bu
but you also reduce rendering times. Keep in m
square movies, or even holes inside movies, by
supporting applications and codecs.

As computer generated movies are by nature r
possible to make movies that are much larger t
large movies may need to be pre-split in order 
“Pre-splitting Large Movies” on page 56), dep
the display computers.
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tion software, often save the 
his may also be the case when 
. Such a sequence of images must 
the appropriate frame rate, before 
is can be done using, for example, 

 all ending in a frame number. This 
or example, File001.tga, 

cts. To assemble a movie from still 
Import, Footage File” on the File 
d select the “<Format> Sequence” 

pecified in Preferences prior to 
any time by choosing “Interpret 

r. Using Autodesk Cleaner, 
 menu and locate the first image in 
 for the desired frame rate.
Chapter 3     Media

Assembling Individual Frames Some applications, most notably 3D anima
resulting frames as individual image files. T
scanning images frame by frame from film
be converted into a QuickTime movie, with 
it can be incorporated into WATCHOUT. Th
Adobe After Effects.

The individual images must be saved as files
number precedes the file name extension: f
File002.tga, File003.tga, etc. 

Assembling using Adobe After Effe
images using Adobe After Effects, choose “
menu, select the first file in the sequence, an
checkbox. The desired frame rate can be s
importing the images, or can be altered at 
Footage, Main” on the File menu.

Assembling using Autodesk Cleane
choose “Open Image Sequence” on the File
the sequence. Cleaner will then prompt you



rency information in the gene-
 come from the source material 
), or be added afterwards (for 

a video clip).

, or movies with holes in them, 
es in many creative ways.

 the movie file, you must choose 
“Millions+” of colors. The “+” at 
n. This is sometimes called 
ation that’s capable of repro-
ation, such as Adobe After 

o stream, storing and playing 
le. Video compression is based 
ds for compressor/decom-
echnology responsible for 
 video. 

ch optimized for a particular 
ents. WATCHOUT supports 

ow codec technologies for play-
ommonly used codecs:

all files. Optimized for camera 
uarter of the video format’s 

ot of computation power, use it 
s at the same time.
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Using Transparency Some applications support inclusion of transpa
rated movie file. Such transparency can either
(for example, a computer generated animation
example, a feathered, round mask applied to 

Being able to create arbitrarily shaped movies
means you can combine moving and still imag

In order to include transparency information in
a QuickTime codec that’s capable of handling 
the end stands for the transparency informatio
“Millions+Alpha”. You must also use an applic
ducing and/or generating transparency inform
Effects. 

Video Compression Due to the large amount of raw data in a vide
back uncompressed video is usually not feasib
on the concept of codecs. A codec (which stan
pressor) is the part of the editing and display t
storing and playing back compressed digitized

There’s a wide variety of codecs available, ea
kind of source material and playback requirem
both Apple QuickTime and Microsoft DirectSh
back. Here’s a rundown of some of the more c

MPEG-1. Medium quality. Generates very sm
video. Native frame size is fixed, based on a q
frame size. Since this codec doesn’t require a l
when you need to play a lot of small video clip

Computer generated movie with 
transparent background and semi-
transparent drop shadow playing 
over a background image.
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o discs. Optimized for camera 
 high definition formats with some 
age 51). The WATCHOUT MPEG-

tically when required.

ery low compression. Optimized 
 transparency when set to 

tructive). Low compression. Opti-
pports transparency when set to 

ptimized for video editing. Gener-
ers. Native frame size is fixed, 
st performance, use the AVI file 
CHOUT.

le in terms of frame size (useful for 
and interlacing/progressive 
ed when using high resolutions at 

s for your source material and play-
entation.

 file formats, some formats tend to 
use MPEG-2 or Windows Media 9 
h case QuickTime Animation is the 
 processor power, but provides 

e sizes.
Chapter 3     Media

MPEG-2. High quality. Used on DVD vide
video at normal frame sizes. Also supports
encoders (see “High Definition Video” on p
2 decoder performs de-interlacing automa

Quicktime Animation. High quality. V
for computer-generated material. Supports
“Millions+” of colors.

QuickTime PNG. High quality (non-des
mized for computer-generated material. Su
“Millions+” of colors.

DV. High quality. Medium compression. O
ated directly by most digital video camcord
based on video format’s frame size. For be
format for DV content to be used with WAT

Windows Media 9. High quality. Flexib
making tall or narrow movies), frame rate 
options. Very demanding on processor spe
full frame rate.

Choosing the right codec and codec setting
back hardware may require some experim

Recommended Compression 
Formats

Although WATCHOUT supports most video
give better results. As a general guideline, 
unless an alpha channel is required, in whic
recommended codec. WM9 requires more
greater flexibility in terms of supported fram



laying at least one high defini-
en be able to play several high 
long as what you need to play 
apable of playing, you should 
ndows Media high definition 

g numerous displays, even 
andle the required resolution as 
omputer generated movies, 
erate your animation software 

es can be played by splitting 
includes only the portion of the 
.

OUT for still images, it is not 
 primary reason for this differ-
st likely have to be compressed 
play computers. To split the 
ecompress each frame, split it 
playback. This would mean that 
e end result would be a loss of 

 storage and bandwidth consid-
original (large) movie in order 
ed in compressing it twice. The 
vie, particularly to achieve the 
56 Chapter 3     Media

Pre-splitting Large Movies Modern computers are generally capable of p
tion movies. Some very fast computers may ev
definition movies at the same time. Hence, as 
fits within the realm of what your computer is c
generally choose either the MPEG-2 or the Wi
format.

However, for extremely large movies, spannin
modern computers may not be fast enough to h
one large movie. This applies in particular to c
which can be made at any resolution and fram
is capable of producing. Such very large movi
them into individual pieces, where each piece 
frame that will play on each display computer

While this splitter function is built into WATCH
handled automatically for moving images. The
ence is that the original, large movie would mo
in order to be stored and distributed to the dis
movie, the display computers would have to d
and then re-compress the result again for final 
each movie frame will be compressed twice. Th
image quality.

In addition to this quality aspect, there are also
erations related to distributing and storing the 
to split it, as well as the processing time involv
latter would be significant for such a large mo
best quality.
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e using the originating application, 
ow you to crop the output to any 
even set up batches to generate all 

800 by 600 pixel displays with a 
 of 1200 by 480 pixels, the split 
ft.

 an example. Most modern 
 movie as is, without pre-splitting it.

tion of the image in the overlap will 
he displays aren’t overlapping you 
dges of the display areas by speci-
e split.

to the initial image size. This means 
calculated based on the height and 

vie into smaller pieces like this, 
 source. Doing so would introduce 
ression step, resulting in lower qual-
ith the original material, such as in-
les.

r. Give each file the name of the 
ar. Select “Pre-split for Multiple 
lder (see “Add Proxy” on page 
Chapter 3     Media

This can all be avoided by splitting the imag
prior to compression. Most applications all
desired rectangle. In some cases, you can 
the individual movie files in one go.

As an example, assume that you have two 
30% overlap, and want to display a movie
would appear as in the illustration to the le

◆ NOTE: These figures are only chosen as
computers would be able to play such a

Include the overlap in the split, since the por
have to play on both displays. Likewise, if t
will have to factor in any gap between the e
fying a corresponding gap when making th

Most applications specify cropping relative 
that the bottom and right edges need to be 
width of the original (large) image.

▲ IMPORTANT: When splitting a large mo
avoid using a compressed movie as the
an additional de-compression/re-comp
ity. Thus, whenever possible, start out w
dividual, computer-generated, image fi

Save the resulting files into a separate folde
WATCHOUT display on which it will appe
Displays” and link the Video Proxy to the fo
120).

A 1200 x 480 movie to be pre-split 
across two overlapping 800 by 
600 display areas.

Crop right 
by 480 
pixels.

Crop left 
by 480 
pixels.



be After Effects:
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This is how you would split a movie using Ado

Crop the resulting movie as 
required on each side.
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t’s very similar to moving images. 
T and place its icon on the display 
 sound file to play.

n so that it straddles multiple 
e same sound file to play from 
ound file play from a computer that 
 places an unnecessary processing 

 file that can be played using 
mmended sound file format is 
ompressed sound file format, such 
 step adds unnecessary load. The 
 not an issue with the kind of 
presentations.

audio using a suitable sound card 
e saved as WAV files using the 
e applications capable of saving 
Nuendo, Digidesign ProTools and 

ulti-channel WAV files from a 
xample the “CDP Multi-Channel 

ls.html
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AUDIO Audio is used in WATCHOUT in a way tha
Simply bring the sound file into WATCHOU
in the Stage window where you want to the

◆ NOTE: Do not place the sound file’s ico
displays, unless you specifically want th
multiple display computers. Having the s
isn’t really used for sound reproduction
load on that computer.

Audio File Formats WATCHOUT can generally play any sound
Windows Media Player. However, the reco
WAV. There’s usually no reason to use a c
as MP3, and the additional decompression
size of uncompressed sound files is usually
computers used to play back WATCHOUT 

Multi-Channel Audio WATCHOUT can play back multi-channel 
(see page 34). Multi-channel sound files ar
“Wave Format Extensible” file format. Som
multi-channel WAV files include Steinberg 
Adobe Audition. 

Free tools are also available for creating m
number of single-channel WAV files. For e
ToolKit”, found here:

http://www.cs.bath.ac.uk/~rwd/mctoo

http://www.cs.bath.ac.uk/~rwd/mctools.html


rack in addition to the video. In 
splay computer(s) as the video 
 out of the movie and place it in 
edia files: one containing the 
ace them separately in 
y computer. You’ll need two 
at the same time.

 compatible video editing soft-
uickTime movie into two sepa-

mposite movie and choose 
u. Select the sound track and 
o its own movie, which you can 
ort command on the File menu.

mpatible, you may not be able 
 file using a video editing appli-
io into a separate track, which 

und as separate cues. You can 
window, allowing the sound 
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Using Embedded Audio Some video and movie files contain an audio t
this case, the sound will play from the same di
does. If you don’t want this, cut the sound track
a file of its own, thereby ending up with two m
video and one the audio. This allows you to pl
WATCHOUT, making the sound play from an
separate cues along the timeline to start them 

You can use QuickTime Pro or any QuickTime
ware to split the audio and video tracks of a Q
rate movies. In QuickTime Player, open the co
“Show Movie Properties” on the Window men
click “Extract”. This extracts the sound track int
then save as an AIFF or WAV file using the Exp

◆ NOTE: If your video file is not QuickTime co
to extract the audio from it. Try opening the
cation, which may allow you to extract aud
can then be exported.

In WATCHOUT, add both the video and the so
now position them independently in the Stage 
track to play through any display computer.
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entation. This is particularly useful 
ows you to bring an image of the 
 to play video from tape or other 
ideo originating from satellite links 

ecting the video source directly to 
ve video. This minimizes the delay 
 support applications – while maxi-
 the video signal. See “Live Video 

the live video image like any other 
ly add the live video object to the 
or Timeline from there. See “Add 

 feed in your presentation, you can 
ars on a computer's screen. This 
point slides, a Web browser, or 
ur presentation.

er’s screen is sent continuously via 
mputers, where WATCHOUT 
le, you can put a plain Powerpoint 
on background, thereby enhancing 
abilities of WATCHOUT.

e VNC server software installed 
” on page 36 for more details. 
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LIVE VIDEO Live video can be integrated into your pres
in speaker support applications, since it all
speaker onto the screen. It can also be used
external video playback devices, or to use v
or video conference feeds.

Video is brought into WATCHOUT by conn
each display computer that will show the li
in the video signal – important for speaker
mizing the quality by avoiding compressing
Input” on page 153 for more details.

From a production viewpoint, you can use 
still image or video played from disk. Simp
Media window and drag it onto the Stage 
Live Video” on page 125 for more details.

COMPUTER DISPLAY Similar to how you can display a live video
also incorporate a live image of what appe
can be used to show Excel graphics, Power
similar software applications, as part of yo

The image displayed on the source comput
the network to the WATCHOUT display co
composites it with other media. For examp
presentation on top of a large, high-resoluti
it with all the high-quality presentation cap

The computer to supply the image must hav
and configured. See “VNC Server Software



ve computer image just like any 
bject to the Media window and 
ee “Add Remote Computer” on 

bove provides excellent image 
equire a fast computer for 
ay not provide full framerate, 
ter somewhat, since it has to 

n being displayed (for example, 

B capture card to bring the 
sentially identical to the “Live 
quires a different capture card 
 of a video camera. 

path Vision RGB-Pro, available 

tm
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From a production point of view, you use the li
other image. Simply add a Remote Computer o
drag it onto the Stage or Timeline from there. S
page 123 for more details.

Using an RGB Capture Card Although the VNC-based solution discussed a
quality at virtually no additional cost, it does r
running the VNC server software. Even so, it m
and may impair the performance of the compu
handle both the VNC server and the applicatio
Powerpoint). 

As an alternative, you may instead use an RG
computer into WATCHOUT. This solution is es
Video” input, described above. However, it re
that can be connected to the computer instead

An example of an RGB capture card is the Data
with one or two inputs from:

http://www.datapath.co.uk/visRGBPRO.h

The Datapath Vision RGB-Pro VGA-
signal capture card.

http://www.datapath.co.uk/visRG?BPRO.htm
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4

d to produce a presentation using 
ady produced the source media 

e display areas and provides a 
ages that appear inside a display 

arranging displays side by side or 
iple displays.

ose “Add Display” on the Stage 
 standard display sizes. Once a 
nd other settings through its Speci-
tions” on page 134).

licking it with the mouse so it shows 
it menu.

e menu, you can not add or manip-

ey do, images that span multiple 
 edges. Alternatively, displays can 

 gap between them, for a videowall 
e window according to the actual 

s or image areas, images that span 
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4 PRODUCTION

This chapter goes through the steps require
WATCHOUT. It assumes that you have alre
files, as described in the previous chapter.

STAGE The Stage window allows you to arrange th
preview of your presentation. Portions of im
will be shown by that physical display. By 
vertically, you can make images span mult

Adding and Removing Displays To add a display to the Stage window, cho
menu. This menu item provides a choice of
display has been added, set its IP address a
fications dialog box (see “Display Specifica

To remove a display, select the display by c
a bold outline, then choose Clear on the Ed

◆ NOTE: If “Online” is selected on the Stag
ulate any displays.

Arranging Displays Displays may overlap each other. When th
displays will be automatically blended at the
be positioned edge-to-edge, or with a small
look. By positioning the displays in the Stag
arrangement and separation of the monitor



 thereby avoid manipulation or 

heir desired positions using the 
merically by selecting a display 
 Type in the desired position, in 
tage (see “Display 

d in order to manipulate the 
its title bar. You can not select 
dow, as this is used to select and 
e. If the “Online” item on the 
, change or delete displays.
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multiple display areas will line up properly. You
adaptation of the images themselves.

To arrange the displays, simply drag them to t
mouse. Alternatively, you can position them nu
and choosing Specifications on the Edit menu.
pixels, relative to the upper left corner of the S
Specifications” on page 134).

◆ NOTES: The Stage window must be selecte
displays. To select the Stage window, click 
the Stage window by clicking inside the win
move images when the window is not activ
Stage menu is activated, you can not select

Non-overlapping displays, 
for example, plasma 

Overlapping displays, using 
projectors.
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 images as well as sound. These 
s, with only minor differences 
” for more details.

 “Add Media File…” on the Media 
desired position in the Timeline or 

 the disk or folder where it is 
s from the Media window.

 media files in a sub-folder of the 
 file. This allows WATCHOUT to 

to move the show elsewhere.
Chapter 4     Production

MEDIA The term “media” refers to moving and still
media types are treated in very similar way
where appropriate. See Chapter 3 “Media

Adding Media To add media to your presentation, choose
menu, or simply drag the media file to the 
Stage window. Media can be dragged from
stored, or you can drag existing media item

▲ IMPORTANT: Whenever possible, store
folder containing the WATCHOUT show
use relative file paths, making it easier 

Media file dragged into timeline…

…appears as a cue in the timeline 
as well as being displayed in the 
Stage window.



its thumbnail in the Media 
e Timeline window, first double-
 proceed as described above.

Refresh” on the Media menu to 
oose “Update” on the Stage 
s well.

 have added many media items 
 media references persist in the 
ctually use them. To remove 
hoose “Select Unused” on the 
u.

sed entries from the Media 
ur hard disk.

y want to keep both the old and 
change your mind. In this case, 
es with different names. To 
window and a file, double-click 
 another file. This will affect all 

 of the same kind. You can not 
for example.
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Editing a Media File You can open a media file by double-clicking 
window. To access the media from a cue in th
click the cue and choose “Locate Media”, then

Refreshing Media Information After making changes to media files, choose “
load those changes into WATCHOUT. Then ch
menu to update the stage with these changes a

Purging Unused Media After working with a show for a while, you may
that are not included in the final version. These
Media window, regardless whether any cues a
such unused media from the Media window, c
Media menu and then “Clear” on the Edit men

◆ NOTE: This operation will only remove unu
window. It will not remove any files from yo

Changing the File Association of a 
Media List Item

Sometimes, when editing a media file, you ma
the new version of the file around, in case you 
you end up with two or more similar media fil
change the link between an item in the Media 
the file name in the Media window and choose
cues that use this media list item.

◆ NOTE: You can only relink it to another file
change from an image file to a sound file, 
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in your presentation but can not 
appen in the following cases:

roduction computer, but you know 
ters. Perhaps the media requires a 
uter, possibly using dedicated 

 production computer.

een pre-split into multiple files (see 
).

 may for other reasons need to be 
isplay computer at a later time.

f these cases. Once a media proxy 
 used on the timeline just like other 
0 for more details.
Chapter 4     Production

Using Media Proxies Occasionally, you may want to use media 
import it simply by dragging. This would h

• The media file isn’t recognized by the p
it can be handled by the display compu
specialized codec in the playback comp
hardware, which is not available in the

• The media file is a large movie that has b
“Pre-splitting Large Movies” on page 56

• The media may not yet be available, or
provided or replaced manually on the d

Use a media proxy to accommodate any o
has been added to the media list, it can be
media items. See “Add Proxy” on page 12



ion of cues and effects, as well 
ntrol the display and presenta-
various aspects of the media.

indow can be controlled using 
increase the precision by which 
r zoom out to get a better over-
e the scale gradually. Changing 
 the timeline or its cues.

f media cues, such as position 
 currently selected cue appear 
e tween pane. 

an toggle between the cue and 

edia onto the timeline and drop 
wn on page 65. Cues can be 

ing relationship. Select multiple 
d dragging diagonally, starting 

me layer. Doing so may cause 
ant images to overlap in time, 
verlapping cues are indicated 
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TIMELINE The Timeline window shows the temporal relat
as the layering of overlapping media. Cues co
tion of media, and use tween tracks to control 

The amount of time displayed in the Timeline w
the buttons in the lower left corner. Zoom in to 
you can position cues and set their duration, o
view. The rightmost button allows you to chang
the time scale has no effect on the behavior of

Tween tracks are used to animate properties o
and opacity, over time. The tween tracks of the
at the bottom of the timeline window, called th

◆ HINT: When tween tracks are visible, you c
tween panes using the Tab key.

Adding Media Cues To add a media cue to the timeline, drag the m
it at the desired layer and time position, as sho
dragged along the timeline to change their tim
cues by shift-clicking the cues, or by clicking an
from a point where there are no cues.

◆ IMPORTANT: Do not overlap cues on the sa
images to display incorrectly. When you w
always put their cues on separate layers. O
by a red warning line above the cues.

Zoom buttons, cue area and tween 
pane.
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o appears in the upper left corner 
. To make the image appear else-
ge window to the desired position. 

 images, hold down the Control key 
ixel at a time. Add the Shift key to 

ally in the Position tween track. 
ition.

w, it may be obscured by a large 
e the large image by clicking the 
isabling Layer Preview” on page 

e window is selected before moving 
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Positioning Media on Stage When media is added to the timeline, it als
of the top/left display in the Stage window
where, drag the image’s preview in the Sta

◆ HINT: For precise positioning of selected
and press the Arrow keys to move one p
move ten pixel at a time.

The position of the image is shown numeric
Click the triangle to reveal the numeric pos

If the image isn’t visible in the Stage windo
image appearing in front of it. You can hid
yellow sun icon in its layer title area (see “D
92).

▲ IMPORTANT: Make sure that the Timelin
the image in the Stage window.

Drag the image in the Stage 
window.

Stage position of the image.



llow you to control the stacking 
 an image towards the front, 
er number. To move the cue 
ift key while dragging. Use the 
ove layers.

e by dragging new media onto 
that cue only, while retaining all 

lex move or other effect using 
e to re-use, then replace its 
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Layering Media The horizontal layers in the Timeline window a
order of images in the Stage window. To move
drag its cue downwards to a layer with a high
without changing its time position, press the Sh
commands on the Timeline menu to add or rem

Changing the Media Association of 
a Cue

You can change the media association of a cu
the cue. This changes the media association of 
other relevant properties.

◆ HINT: This can be used to duplicate a comp
different media. First make a copy of the cu
media association as described above.

Click triangle to expand the layer 
to see the entire cue.

Drag to move the partition between 
the cue pane and the tween pane.

Drag to resize the tween track.
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e duration of the cue is set to the 
ages to the timeline, the duration 

 change the duration by selecting 
ed at either end of the cue. 

their tween points will, by default, 
line. To make the tween tracks 
he Alt key while dragging the bar.

in on the stage for the duration of 
 be cut short by decreasing the 
 beyond the actual length of the 

ame visible. Extending the duration 

age cue changes the starting time 
 the in-time of the movie. To change 
ange its “In-Time” value.

on the Timeline menu to align cues 
rrent time position (see page 91), 

rent time position. 

irst de-select “Click Jumps to Time” 

 the Timeline window, you can also 
Cue Specifications dialog box. 
 the Edit menu, or simply double-
age 141 for more details.
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Changing a Cue’s Duration When adding moving images or sound, th
duration of the media. When adding still im
of the cue is set to a default value. You can
the cue and dragging the vertical bar locat

◆ NOTE: If the cue has any tween tracks, 
remain stationary in relation to the time
contract or expand with the cue, press t

For still images, the image will simply rema
the cue. A moving image or sound file can
duration of the cue. Increasing the duration
media will make a movie stop with its last fr
of a sound file has no effect.

◆ NOTE: Dragging the start of a moving im
along the timeline only. It does not affect
the in-time, double click the cue and ch

Aligning Cues in Time Use the “Snap to Current Time” command 
or tween points in time. First position the cu
then drag the cue or tween point to the cur

◆ NOTE: To use this command, you must f
on the Timeline menu (see page 130).

Cue Specifications In addition to direct manipulation of cues in
set most parameters numerically using the 
Select the cue and choose Specifications on
click the cue. See “Cue Specifications” on p



ontrol cues to the timeline by 
enu. When reached during 

e timeline to stop. This is useful 

e with the start of another cue, 
. If you don’t do this, the Control 
u may want to dedicate a layer 

managing the flow of your 
pport or other similar situations 
are involved. For more details, 
Control Cue” on page 150.
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Using Control Cues In addition to media cues, you can also add c
choosing “Add Control Cue” on the Timeline m
playback, a Control cue set to Pause causes th
when cueing a presentation manually.

◆ NOTE: If you want a Control cue to coincid
then put the Control cue on a separate layer
cue may be hidden behind the other cue. Yo
for control cues only.

Control cues provide many other functions for 
presentation. This is often useful for speaker su
where live elements of unpredictable duration 
see “Looping and Jumping” on page 83 and “

A Control cue added to the 
timeline.
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 dynamically throughout the cue. 
n track to make an image fade in 
 the volume of a sound or movie 

en chose the desired type of tween 
 removed in the same way.

 in the tween pane at the bottom of 
see more tween tracks. Likewise, 
to see more details.

 be removed.
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TWEEN TRACKS Tween tracks control the behavior of media
For instance, you can use an Opacity twee
and out, or a Volume tween track to reduce
file.

Adding and Removing a Tween 
track

To add a tween track, first select the cue th
track on the Tween menu. Tween tracks are

The tween tracks of the selected cue appear
the Timeline window. Drag the partition to 
you can adjust the height of a tween track 

◆ NOTE: The Position tween track can not

Drag this partition to enlarge the 
tween pane.

Tween pane.



itself unless you use it to change 
done by adding and adjusting 
en points provide values acting 

urve in the tween track where 
alue of a tween point, drag it 
ge the tween track by dragging 
ultiple tween points to move 

g to constrain the movement of 

gged past their neighbors. To 
 dragging.

r by dragging from a position 
ints can then be edited using 

y to move complex tween tracks 
d pasting the tween points.

ng its end, you have the option 
t time positions or making them 
 was a rubber band. Press the 
 effect.

 points: corners and smooth 

 method to create smooth 
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Adding Points Adding a tween track to a cue has no effect in 
the value governed by the tween track. This is 
tween points along the tween track. These twe
as key-frames along the cue’s tween track.

To add a tween point, click anywhere on the c
there isn’t already a tween point. To edit the v
using the mouse. For better precision, first enlar
the partition between the tween tracks. Select m
them together. Press the shift key while draggin
the tween points.

◆ NOTE: Normally, tween points can’t be dra
relax this constraint, press the Alt key while

Removing, Cutting and Pasting 
Tween Points

Select multiple tween points by Shift-clicking, o
outside all tween points. The selected tween po
commands on the Edit menu. This makes it eas
from one cue to another, by simply copying an

Stretching Tween Tracks When changing the length of a cue by draggi
of either leaving its tween points at their curren
expand and contract with the cue, as if the cue
Alt key during the drag to get the rubber band

Corners and Smooth Tween Points For simple values, there are two kinds of tween
points. 

◆ NOTE: Position tween tracks use a different
motion, as described on page 78.
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ped tween point. A sequence of 
adually, and linearly, between the 
articularly when controlling opacity 

ween point, and is added by 
 the curve by a rubber band. When 
curve, the rubber band stretches, 

lick to open its dialog box. See the 
r “Tween Tracks” on page 145 for 
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A corner is represented by a diamond-sha
corner points causes the value to change gr
points. Often, this is the desired behavior, p
or volume.

A smooth point is represented by a round t
Control-clicking. It acts as a pin attached to
you move the smooth point away from the 
causing the curve to bend. 

Editing Tween Points Numerically To edit a tween point numerically, double-c
description of each type of tween track unde
more details.

Add a corner point by clicking the 
curve.

Add a smooth tween point by 
Control-clicking.



nd out, or to make objects semi-
another, you only need to fade 
 need to do anything to the 
e front image.

 image contains transparent or 
 visible (see “Transparency” on 
ade out the image below to 

and moving images. See 

e of sounds and movies 
ral sounds simultaneously, and 
ile fading out the other. See 

ages. This is particularly useful 
ut can also be used as an effect 
 dragging the tween point, you 
ng handle. This appears in the 
 Scale tween track. Press Shift 
 the image.

an flip or mirror the image.
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OPACITY Use an opacity tween track to fade objects in a
transparent. To cross-fade from one image to 
the opacity of the front-most image. You don’t
image behind it, as this will be obscured by th

There is one exception to the above rule. If the
semi-transparent areas, the back image will be
page 49). In this case, you may also need to f
perform a smooth cross-fade.

An opacity tween track can be applied to still 
“Opacity” on page 146 for more details.

VOLUME Use a volume tween track to control the volum
containing embedded audio. You can play seve
cross fade between them by fading up one wh
“Volume” on page 146 for more details.

SCALE Use a scale tween track to change the size of im
for playing video material at full screen size, b
for both still and moving images. In addition to
can also adjust the scale by dragging the scali
lower right corner of the image after adding a
while dragging to maintain the aspect ratio of

◆ HINT: By using negative scale values, you c

See “Scale” on page 147 for more details.

Scaling handle.
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le of images, or to make an image 
ing the rotation handle or the rota-
s as well as by number of revolu-
otation” on page 149.

en underneath the anchor point. If 
cribed below, or drag the tween 

point. The anchor point is indicated 
see illustration above). To change 
change the values under “Anchor 
tions” on page 141 and “Anchor 

ging a 
n point.
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ROTATION Use a rotation tween track to control the ang
rotate over time. Rotate the image by dragg
tion tween point. You can rotate by degree
tions (or a combination of the two). See “R

◆ NOTE: The rotation handle may be hidd
so, either move the anchor point as des
point to adjust the angle.

ANCHOR POINT Images scale and rotate around the anchor 
by a white crosshair in the Stage window (
the anchor point, double-click the cue and 
Position within Image”. See “Cue Specifica
Position” on page 144 for more details.

Rotate by dragging 
the rotation handle…

…or by drag
rotation twee

Anchor 
point.



ge on stage, or to make an 
al images on stage, then drag 
 an arrow key while holding 
es one pixel at a time. Press the 

ts.

removed, since all images must 
ove unwanted position tween 
n the Edit menu.

cation at a particular time, first 
sition the image in the Stage 

already existing tween point, 
point before moving the image. 
ead. To ensure that the timeline 
t all tween points, then click the 
cted on the Timeline menu.

 to the motion path in the Stage 
oint to type in the desired stage 
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POSITION Use the position tween track to position an ima
image move along a path. Select one or sever
them in the Stage window. Alternatively, press
down the Control key to move the selected imag
Shift key as well to move in 10 pixel incremen

◆ NOTE: The Position tween track can not be 
have a position in order to appear. To rem
points, first select them then choose Clear o

Editing Position Points To make an image arrive at a specific stage lo
add a tween point at the desired time, then po
window as described above. 

◆ NOTE: To change the stage position of an 
make sure the timeline is positioned at that 
If not, a new tween point will be added inst
is positioned at a tween point, first de-selec
tween point with “Click Jumps to Time” sele

Alternatively, drag one of the handles attached
window, or double-click the handle or tween p
position of the image.
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t add a tween point by clicking at 
ack, then drag the image to the 
 indicates the image’s motion path 
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Moving Along a Path To make the image move along a path, firs
the desired time position along the tween tr
desired position in the Stage window. A line
in the Stage window.

Controlling the Speed of Motion Double-click a position tween 
point to change its incoming 
or outgoing speed. A value of 
1 indicates nominal speed, 
with smaller values being 
slower and greater values 
being faster. The speed is 
indicated by the white dots 
along the motion path, with 
dots spaced farther apart indi-
cating faster motion.



rner along the motion path. To 
e point and select Smooth. You 
 the motion independently. 
irection handle, controlling the 

se the dialog box and drag the 
 a curve. 

en set to move the image along 

m the point increases the curva-
he path’s shape.

o rotate the object accordingly 
n in the example above.
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Moving Along a Curved Path By default, a Position tween point acts as a co
move smoothly through a point, double-click th
can control the incoming and outgoing part of
Selecting the Smooth option reveals a yellow d
path of motion into or out form that point. Clo
yellow handle in the desired direction to create

In the illustration below, smooth points have be
an S-shaped curve.

Dragging the direction handle farther away fro
ture. Add tween points for better control over t

◆ HINT: You can use a Rotation tween track t
as it moves along the motion path, as show

Direction handles.
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5

TCHOUT presentation from your 
uters, and run the presentation. It 

resentation can be used and 

tion and display computers, 
e display software on each display 
tage menu. This causes the produc-
puters and transfer all required 

indicated by an error icon in the 
 the WATCHOUT display software 
ble-check the network configura-
ly (see “Network” on page 32 and 
firm that the IP address of the 
 Display Specifications dialog box 

).

nnecting to the display computers 
ATCHOUT and/or on the display 

 Alt-F4 on the display computer.
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5 PRESENTATION

This chapter tells you how to take your WA
production computer onto the display comp
discusses the various ways in which your p
controlled.

CONNECTING TO THE DISPLAY 
COMPUTERS

After installing and configuring the produc
producing the presentation, and starting th
computer, you can select “Online” on the S
tion computer to connect to the display com
information to them, ready for playback.

Failure to connect to a display computer is 
Stage window. If you get a error icon, quit
on the offending display computer and dou
tion to ensure that it has been set up proper
“Computer Settings” on page 38). Also con
display computer matches the settings in the
(see “Display Specifications” on page 134

Any further problems encountered after co
will be reported in the Message window in W
computer’s screen.

Quitting the Display Software To quit the display software, press Ctrl-X or

Error icon indicates a problem 
connecting to the display computer.



eck to make sure that all 
the display computers. 
 required on the individual 
UT will detect this and transfer 

splay computer, a progress bar 
ow, as well as on the display 

WATCHOUT while files are 
urther update or access the 
d.

by deselecting “Online” on the 
urrent file has been transferred.

lay computer will remain there 
 show is stored in a folder with 

ws” folder in the same folder as 

 you may want to clean up the 
sh and emptying the trash 

w. This stops old shows from 

ache” folder, then remember to 
le is used to keep track of what’s 
oblems displaying certain 
 folder and the “CachedFiles” 
next time you open the show.
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Downloading Media Whenever you go online, WATCHOUT will ch
required media files have been transferred to 
WATCHOUT will only transfer the files actually
computer. If you modify a media file, WATCHO
the updated file.

While media files are being transferred to a di
will be shown in that display in the Stage wind
computer itself. You may continue working in 
being transferred, but you will not be able to f
display until the previous update has complete

◆ HINT: You can stop an update in progress 
Stage menu. The transfer will stop once the c

Note that all media files transferred to the disp
until removed manually. The media related to a
the name of the show. This is located in a “Sho
the WATCHOUT display software application.

After using a display computer to run a show,
Shows folder by putting its contents into the tra
before using that computer to run another sho
occupying hard disk space unnecessarily.

◆ NOTE: If you for any reason remove the “C
remove the “CachedFiles” file as well. This fi
in the “Cache” folder. If you experience pr
images, you may try removing the “Cache”
file. WATCHOUT will re-create this file the 

The “Shows” folder contains a folder 
related to each show that has been 
transferred to the display computer.
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line, transfer them to the display 
n the Stage menu. This includes 

 display computers, the 
s will disappear. You are now 
ick the play button in the lower left 
 spacebar.

e by clicking in the time ruler at the 
line Settings” on page 131).

trolled presentations, add Control 
T performs the instructions 

 or jumps to another position along 
n page 83).

o to any location in your presenta-
f the function keys on your 
 “F1”), then press that function key 
e” on page 130.

e timeline (see “Add Control Cue” 
50). By combining this with the 
dby command (page 119), you 
ections of the presentation. These 
g a TOUCHDOWN control panel. 
re details.
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Updating the Stage If you make changes to your show while on
computers using the “Update” command o
adding new media or cues.

RUNNING THE PRESENTATION Once all media has been transferred to the
WATCHOUT logo on the display computer
ready to run your presentation. To run it, cl
corner of the Timeline window, or press the

You can jump to any point along the timelin
top of the Timeline window (see also “Time

Manual Control For speaker support, or other manually con
cues to the timeline. When run, WATCHOU
embedded in the cue – for example, pauses
the timeline (see “Looping and Jumping” o

You can also use Control cues to instantly g
tion. Give the cue the same name as one o
computer’s keyboard (for example, name if
to jump straight to it. See “Add Control Cu

Looping and Jumping Use a Control cue to loop any segment of th
on page 130 and “Control Cue” on page 1
QuickFind feature (page 115) and the Stan
can gracefully exit loops or jump to other s
features can also be accessed remotely usin
See the “GUIDEMAKER Handbook” for mo



dinary computer to remotely 
ll as the presentation environ-
details:

s where personalized or multi-
OUT together with Dataton 
tation, and acts as a remote 

isplay clusters, use the Dataton 
o your Ethernet network. In 
KUP it also controls your 
ed features such as synchro-
nguage selection between 
lling the conditional layers in 
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Touch panel or Computer Control You can use Dataton TOUCHDOWN or an or
control your WATCHOUT presentation, as we
ment. See the “GUIDEMAKER Handbook” for 

http://www.dataton.com/touchdown/

Personalized or Multi-lingual Audio For museums, visitor centers, and similar place
lingual audio is desired, you can use WATCH
PICKUP. PICKUP plays the audio of the presen
control for starting the presentation.

http://www.dataton.com/pickup/

To integrate PICKUP with your WATCHOUT d
NETWORK TRANSPONDER, which connects t
addition to acting as an IR transponder for PIC
WATCHOUT presentations. It provides advanc
nized audio playback. It can also match the la
PICKUP and WATCHOUT by means of contro
WATCHOUT (see “Condition” on page 93).

http://www.dataton.com/pickup/
http://www.dataton.com/touchdown/
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ant to integrate WATCHOUT with 
ished by means of external control 
twork.

t the external controller to the 
rt in the Preferences dialog box.

twork protocol, and allows 
HDOWN touch panel or from 
rk (see page 181).
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EXTERNAL CONTROL For more complex applications, you may w
other control systems. This can be accompl
of your WATCHOUT system through the ne

To control the production computer, connec
network and activate the TCP/IP control po

Network control is based on the TCP/IP ne
WATCHOUT to be controlled from a TOUC
another computer anywhere on your netwo

Activates external control through 
the network port on the produc-
tion computer.



tion software, as discussed 
display computers directly. This 
uring playback. Please see 
tails.

ioned above, you may use stan-
e timecode signal to LINE IN of 
code synchronization using the 
ge 195.

trol the display cluster for play-
 the WATCHOUT production 

es online, it temporarily disables 

r application on the primary 
e reception, quality and signal 
 the appropriate input on the 
 remains in effect after closing 
CHOUT display software.

 to adjust the input level, if 
 Audio Devices, Audio, Sound 
 system-wide. Changing it 
ions may affect the ability of 

 leave it running when starting 
 its own timecode reader.
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Display Cluster Control Instead of controlling the WATCHOUT produc
above, you may choose to control a cluster of 
removes the need for a production computer d
“Display Cluster Protocol” on page 185 for de

TIMECODE CONTROL In addition to the display cluster protocol ment
dard timecode to control the cluster. Connect th
the primary display computer and activate time
timecodeMode command, as described on pa

◆ NOTE: This feature can only be used to con
back. It can not be used in conjunction with
software. When the production software go
any timecode input to the cluster.

Use the separate WATCHOUT Timecode Teste
computer in the cluster to verify proper timecod
level. Connect the timecode signal and choose
“Sound Mixer Input” pop-up menu. This setting
the Timecode Tester, and will be used by WAT

◆ HINT: Use the Windows sound input mixer
required. Go to Control Panel, Sounds and
Recording, Volume. Note that this setting is
through this control panel or other applicat
WATCHOUT to read timecode.

Quit the Timecode Tester after using it. Do not
WATCHOUT display software, which contains

WATCHOUT Timecode Tester.
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6
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6 WINDOWS

Stage Window, 
showing the display 
areas and a preview of 
the presentation.

Timeline Window, 
showing the layers, cues 
and tween tracks.

Media Window, 
listing all media used 
in your presentation.

Message Window, 
showing messages and 
errors.



top window, with a menu bar 
op window by dragging any of 
mize it using the buttons in the 
uivalent to choosing Quit on the 

 title bar. Resize a window by 
inimize and maximize a 

rner. Windows can not be 
the bottom of the desktop 
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Manipulating Windows All WATCHOUT windows reside inside a desk
running along its top. You can resize the deskt
its outer borders or corners. Minimize or maxi
upper right corner. Clicking the close box is eq
File menu.

Move a WATCHOUT window by dragging its
dragging any of its corners or outer borders. M
window using the buttons in the upper right co
closed – only minimized into small tabs along 
window.

Minimize, maximize and close 
the WATCHOUT desktop.

Menu bar.

Minimize and maximize.

Drag border or corner to resize.

Minimized windows. Click to 
restore.
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nge the display areas used in the 
your presentation as you move 
media on stage.

ng it to the desired location in the 
e added to the Timeline window at 
n. To remove the media from the 
ue from the timeline.

ing it in the Stage window. To do 
ag the image in the Stage window. 
e position is displayed numerically 
 Media on Stage” on page 69). 
 stage. Double-click a Position 

ee “Position” on page 148).

en point, first click the tween point 
e the image. If you don’t go to the 
y be added instead.

◆ NOTE: To add a display to the 
Stage window, choose Add 
Display on the Stage menu. 
See Chapter 8 for more details 
on displays.
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STAGE WINDOW The Stage window is used to add and arra
presentation. It also provides a preview of 
along the timeline, and lets you to position 

Adding Media Add media to your presentation by draggi
Stage window. A corresponding cue will b
the currently selected layer and time positio
stage window, remove the corresponding c

Positioning Media on Stage You can position media on stage by dragg
so, first select the Timeline window, then dr
Press the Shift key to constrain the move. Th
in the Position tween track (see “Positioning
Press Control-arrow key to nudge media on
tween point to edit its values numerically (s

▲ IMPORTANT: To change a position twe
to go to its exact time position, then mov
tween point first, a new tween point ma

On/Off line indicator, corre-
sponding to the “Online” 
Stage menu item.

Displays added to the Stage 
window.

Selected display.



 up your presentation. Cues are 
o-front stacking order of images 
mage closer to the front.

ls windows vertically. The scroll 
difier keys in the Timeline 

 second increments.

in 1 second increments.

and out by a fixed amount. 
ypad has the same effect. Drag 

Jump button.

Time ruler.

Layer.

Tween pane.

Time scale buttons.
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TIMELINE WINDOW The Timeline window holds the cues that make
arranged along layers, representing the back-t
on stage. Increasing layer numbers move the i

Using the Scroll Wheel By default, the scroll wheel on the mouse scrol
wheel can be combined with the following mo
window:

Shift: Scrolls the timeline horizontally.

Control: Moves the current time position in 0.1

Control+Shift: Moves the current time position 

Adjusting the Time Scale Click the magnifying glass buttons to zoom in 
Pressing the ‘+’ and ‘–’ keys on the numeric ke

Current time position and indicator.

Currently selected layer.

Collapsed layer.

Layer attributes.

Disabled layer preview.

Play button.
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ss buttons to change the scale 

n. To set the time numerically, 
menu. To go to the beginning of a 
 Jumps to Time” selected on the 
n page 130).

vertical, colored line through the 
 current jump/snap behavior, as 

f the time ruler, to jump to the 
r to jump back to the previous start 

ric keypad has the same effect.

ack. If the stage is online, this also 
ck, the Stage window shows a 

ects. Pressing the spacebar is 

disk or the Media window to the 
for more details on cues.

y selected layer. When pasting an 
nt time and layer. Likewise, when 
indow, a new cue will appear at 
Chapter 6     Windows

the button to the right of the magnifying gla
gradually.

Setting the Current Time Position Click the time ruler to jump to a time positio
choose “Timeline Settings” on the Timeline 
cue, or to a tween point, click it with “Click
Timeline menu (see “Click Jumps to Time” o

Time Position Indicator The current time position is indicated by a 
Timeline window. Its color indicates the the
shown in the illustration on page 131.

The Jump Button Click the jump button, located to the right o
current time position if scrolled out of view, o
time. Pressing the asterisk key on the nume

Starting and Stopping Click the play button to start and stop playb
controls playback on screen. During playba
preview of images, movies and applied eff
equivalent to clicking the play button.

Adding Cues To add a cue, drag media from your hard 
Timeline or Stage window. See Chapter 9 

Selecting the Current Layer Click a layer’s name to make it the currentl
individual cue, it will be pasted at the curre
adding media by dragging into the Stage w
the currently selected time and layer.



tore the layer height. Shift-click 

using the corresponding 

ow, click the layer preview 
le all layers. Disabling a layer 

window that otherwise would 
 a layer’s preview has no effect 

yer, first select the layer then 

edia on this layer will perform 
o keep, for example, a back-

les layer preview in the Stage 
w (see also page 92).

nditional layers, enter a layer 
tion number here. Set to zero 
normal (unconditional) layer.
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Changing Layer Height Click the collapse triangle to minimize and res
to collapse/expand all layers.

Adding and Removing Layers Layers can be added, removed and renamed 
commands on the Timeline menu (page 92).

Disabling Layer Preview To disable the layer preview in the Stage wind
symbol to turn it off. Shift-click to disable/enab
allows you to manipulate images in the Stage 
have been covered by other images. Disabling
on its playback on screen.

Layer Name and Attributes To change the name or other attributes of a la
choose “Layer Settings” on the Timeline menu.

Perform Normal/In Standby By selecting “In Standby”, images and other m
only when in Standby mode. This allows you t

Layer name.

Images and other media on this 
layer are displayed when in 
Standby mode only.

Disab
windo

For co
condi
for a 
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 time, thereby avoiding going to a 
ode (see “Standby” on page 119).

w media controlled from such 
 the “Preview Standby Layers” 
 Standby Layers” on page 118).

 the Standby command at any time, 
essor and memory resources even 
le standby layers at the same time 

ntent on standby layers. Generally, 
age at a time.

l layer will perform only when that 
og box (see “Enabled Layer Condi-
ep, for example, multiple language 
g the desired language version to 
dition.

ia on enabled conditional layers 
iew Options” on the Stage menu 
rs” on page 118).

ndby layer is shown in italics in the 
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ground image ready to be displayed at any
black screen when activating the standby m

Normally, the Stage window doesn’t previe
standby layers. You can override this using
command on the Stage menu (see “Preview

▲ IMPORTANT: In order to be available to
media on standby layers consume proc
while not in standby. Avoid using multip
or playing video or other heavy-duty co
use only a single, large background im

Condition Media associated with cues on a conditiona
condition is enabled in the Preferences dial
tions” on page 110). This can be used to ke
versions of a show in the same file, allowin
be activated by enabling its associated con

Normally, the Stage window previews med
only. You can override this using the “Prev
(see “No / All / Enabled Conditional Laye

◆ NOTE: The name of a conditional or sta
Timeline window.



ve been added to the presen-
 item, along with a description 

information, as appropriate for 

rd disk into the Media window, 
ia menu. Files dragged directly 

atically added to the Media 
presentation will only appear 
 many times it is being used.
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MEDIA WINDOW The Media window lists all media items that ha
tation. It provides a thumbnail preview of each
of its name, type, file location, size and other 
each kind of media.

Adding Media Add new media by dragging files from your ha
or by choosing “Add Media File…” on the Med
into the Timeline or Stage windows are autom
window as well. Each media file used in your 
once in the Media window, regardless of how

Drag to change column width.

Thumbnail and description of each 
media item.

Double-click thumbnail to open 
media file in its associated applica-
tion.

Double-click name to edit the 
media specification.

Media can be grouped into 
folders.
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 them and choosing “Clear” on the 
 from the Media window by first 
nu. It is not possible to remove 
tion. Removing media list items in 

your computer’s hard disk.

eline window to track down media 
m.

the file is located in or under the 
ed, the path to the file will be rela-
bsolute path, beginning with a ‘/’-

es in a sub-folder of the folder con-
lows the use of relative path names. 
resentation to another folder, disk 

 names may cause problems if the 
moving the presentation.

g file locations, you may move the 
 example, to a folder under the 
n use the Find/Replace command 

ndow accordingly. See “Find/

articular media list item by double-
another file. This will affect all cues 
n only replace a media file with 
Chapter 6     Windows

Removing Media Remove individual media items by selecting
Edit menu. Remove all unused media items
choosing “Select Unused” on the Media me
media that’s currently in use in the presenta
this way does not affect the files stored on 

◆ HINT: Use the Find command in the Tim
references by the name of the media ite

File Location Indicates the location of each media file. If 
folder in which the presentation itself is sav
tive to this folder. Otherwise, it will be an a
character.

▲ IMPORTANT: If possible, store media fil
taining the presentation file, since this al
Doing so allows you to move the entire p
or computer intact. Using absolute path
specified location is not available after 

◆ HINT: If you change you mind concernin
files to a more appropriate location (for
folder containing the show file), and the
to update the locations in the Media wi
Replace” on page 114.

Changing the File Association You can change the file associated with a p
clicking the Description field and choosing 
associated with this media list item. You ca
another of the same type.



ion, double-click its thumbnail. 
 in order to view or edit it. 

p properly in order to associate 
tion.

in WATCHOUT accordingly by 
efresh” on page 129 for more 

se “New Folder” on the Media 
media items onto the folder. 
ick the triangle to show or hide 

o relation to folders on your 
y to organize items in the Media 
 the Media window will not 

 disk.

ragged into the Media list (see 
 add a proxy item to the Media 
he Media menu. See “Add 
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Editing the Media File To open a media file in its associated applicat
This provides convenient access to a media file

◆ NOTE: Your computer must have been set u
each file type with the appropriate applica

Refreshing Media Information After editing media files, update the Media list 
choosing “Refresh” on the Media menu. See “R
details.

Grouping Media Items into Folders Media items can be arranged into groups. Cho
menu to create a folder then drag the desired 
Double-click the folder’s name to change it. Cl
the content of the folder.

◆ NOTE: Folders in the media window have n
computer’s hard disk. They are merely a wa
window. Creating or removing folders from
create or remove any folders on your hard

Adding a Media Proxy In some cases, media files can not simply be d
page 67 for some examples). Instead, you can
window using the “Add Proxy” command on t
Proxy” on page 120 for more details.
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nt to you by WATCHOUT. Such 
n software or from the display 

rmative while others indicate errors 

utomatically when the first message 

shift-clicking or by choosing “Select 
 on the Edit menu.
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MESSAGE WINDOW The Message window lists the messages se
messages may originate from the productio
computers. Some messages are merely info
requiring your attention.

◆ NOTE: The Message window appears a
is posted. 

Removing Messages To remove messages, select them (either by 
All” on the Edit menu) then choose “Clear”

An error message from a media list 
item telling you that it can’t find its 
associated media file.

An information message reporting 
the result of the Refresh command.



anager” command on the File 
ense keys. This list is stored as a 
plication on the production 

ATCHOUT license key.

is license key.

 not yet been stored in their 
t the key with the specified 
 When successfully stored in the 
 Pending to the Version column.

r to which this key was 
empty if the key was connected 

duction computer and (option-
d will be added/updated in the 
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LICENSE WINDOW This window is opened using the “License Key M
menu. It displays a list of your WATCHOUT lic
file in the same folder as your WATCHOUT ap
computer.

License A unique license number stored inside each W

Version The version(s) of WATCHOUT supported by th

Pending Shows upgrades you have acquired that have
license keys. To update the license key, connec
license number and press “Scan License Keys”.
key, the version number is transferred from the

Location The name and address of the display compute
connected when last encountered. This field is 
directly to the production computer.

Scan License Keys Searches for license keys connected to the pro
ally) any on-line display computers. Those foun

Supported WATCHOUT versions.

Acquired update not yet stored into 
the license key.

Where this license key was last 
encountered.
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ending upgrade, this will be trans-
d to the Version column.

 any on-line display computers will 
 license keys.

 to the clipboard as text. This infor-
 for license keys (see “Upgrading 
 you can copy the information from 
ting those in the list (Control or 

choosing Copy on the Edit menu.

 keys either to the production 
r, then click “Scan License Keys”. 
ecting them and choosing Clear on 
Chapter 6     Windows

list. If any key found during the scan has a p
ferred to the key and the entry will be move

Scan Online Displays Too Controls whether license keys connected to
be included when looking for or upgrading

Copy All as Text Selects all licenses and copies their content
mation is needed when ordering upgrades
your Licenses” on page 100). Alternatively,
specific license keys only by manually selec
Shift-click to select multiple keys) and then 

Adding and Removing Licenses Add new licenses by connecting the license
computer or to any online display compute
Licenses can be removed from the list by sel
the Edit menu.



troduced, old license keys must 
section outlines the procedure 

 license key upgrades. Minor 
version 3.1) do not require an 

ant to upgrade are listed in the 
utlined on the preceding pages 

 license key with that specific li-
 match those to be upgraded.

 click “Copy All as Text” to copy 
atively, manually select the 
 the Edit menu.

m your Dataton reseller or 
our upgrade through your 

 including your ordering infor-
se keys in the previous step. 

s.
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Upgrading your Licenses When a major new version of WATCHOUT is in
be upgraded in order to use that version. This 
used to upgrade license keys.

◆ NOTE: Only major version changes require
changes (for example, from version 3.0 to 
upgrade.

Obtaining the Information Start by making sure that all the licenses you w
License window. If not, follow the procedure o
for adding your licenses to the list.

▲ IMPORTANT: An upgrade applies only to a
cense number. Make sure the licenses listed

Once all licenses to upgrade appear in the list,
the license information to the clipboard. Altern
licenses to be upgraded, then choose Copy on

Ordering the Upgrade You can order your license upgrades either fro
directly from the Dataton web shop. To order y
Dataton reseller, send an e-mail to the reseller
mation as well as the text copied from the licen
Contact your Dataton reseller for further detail
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 to

will receive an e-mail with your 
-mail and paste it into the “License 
formation will appear in the 
s to the computer and click “Scan 
ation into the license keys. When 

formation is transferred from the 
graded license keys can be used 
 version of WATCHOUT.
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To order through the Dataton web shop, go

http://www.dataton.com/

Once your order has been processed, you 
upgrade information. Select all text in that e
Key Manager” window. The new license in
“Pending” column. Connect the license key
License Keys” to transfer the pending inform
successfully stored in the license key, the in
Pending column to the Version column. Up
with both your original version and the new

❹ Follow on-screen instructions.

❸ Click WATCHOUT and scroll 
down to WATCHOUT 3 Upgrade.

❷ Apply for login name
or

❷ Enter name and password.

❶ Click LOGIN.

http://www.dataton.com/
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7

to the entire presentation, such as 
 ones.

 name and location of the 

 arrangements and cues, simply 
n paste them in the new one.
Chapter 7     Commands

7 COMMANDS

FILE MENU The File menu provides commands related 
Opening old presentations or creating new

New Creates a new presentation, specifying the
WATCHOUT presentation.

◆ HINT: To re-use objects such as display
copy them from the old presentation the

Navigate to the desired folder 
using this pop-up menu and by 
double-clicking folders.

Type the name of the show here, 
then click Save.



s. Choosing an item from the 

ly open. This is useful for saving 
he current presentation.

out changing it back to its orig-
 be downloaded to all display 
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Open Opens an existing WATCHOUT presentation.

Open Recent Provides a list of recently opened presentation
sub-menu opens the selected presentation.

Save Saves the presentation that is currently open. 

Save a Copy As Saves a copy of the presentation that is current
backup copies without changing the name of t

◆ NOTE: Opening and using such a copy with
inal name will cause a new set of media to
computers under the new name.

Navigate to the containing folder.

Select the desired show then click 
Open.
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luding all actively used media files, 
onsolidate all the relevant files in 
nto a CD or DVD.

using media files stored on servers 
unused media files intermixed with 
at you want to weed out.

repare a package with all files 
T command in GUIDEMAKER (see 
.

edia files, this command also 
 Media window, and stores this 
 consolidated folder. When using 
ed.

 an empty folder for your consoli-
with the dialog box shown below, 
 move the media files.
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Consolidate To Moves or copies the entire presentation, inc
to a folder. You can use this command to c
preparation for burning the presentation o

This command is also useful if you’ve been 
or removable disks, or if you have a lot of 
the files actually used in the presentation th

A third application of this command is to p
needed by the “Update Show” WATCHOU
the “GUIDEMAKER Handbook” for details)

In addition to collecting the actively used m
updates the access paths accordingly in the
updated copy of the presentation file in the
Move, the old presentation file is not affect

When you give this command, first choose
dated presentation. You’re then presented 
allowing you to choose whether to copy or



on, leaving the current media 
is the safest option, but may 
pace, since it entails making 
 the presentation.

sentation is copied. Unused 
indow in the consolidated 

e left in their old locations, and 

e same volume as the target 
ster and requires no additional 
et volume. Media files residing 
ied, however. The consolidated 

 media files away from the 
ion, you will no longer be able 
fers to has been moved. A new 
e consolidated folder with the 

ides the information needed to 
leased (see page 98).

 changes.
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Copy. Creates a new copy of your presentati
files and the presentation file as they are. This 
require a significant amount of time and disk s
new copies of every media file actively used in

◆ NOTE: Only media actively used in the pre
media items are removed from the Media w
version of the show. Unused media files ar
are not copied or moved.

Move. Moves all media files that reside on th
folder instead of copying them. This is much fa
disk space for files already located on the targ
on other disks, partitions or servers will be cop
presentation is then opened automatically.

▲ IMPORTANT: Since the Move option moves
locations specified in the original presentat
to use the old presentation file as media it re
copy of the presentation file is created in th
updated media file references.

License Key Manager Displays your WATCHOUT licenses, and prov
upgrade them when new major versions are re

Quit Quits WATCHOUT after optionally saving any
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s of the presentation.

sually only differ in the last few 
ring the common initial part in this 
w digits into the specifications 
“Address” on page 134).

 that separates the last two groups 
 made by simply concatenating the 
 field with the contents of the dis-

Sets the frame rate to 
be used by your 
display computers.

Default anchor posi-
tion for new image 
cues.
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Preferences Allows you to specify miscellaneous setting

Display Address Prefix The IP addresses assigned to the displays u
digits (see illustration on page 40). By ente
field, you then only have to enter the last fe
dialog box of each individual display (see 

▲ IMPORTANT: You must enter the period
of digits here. The complete IP address is
contents of the “Display Address Prefix”
play’s Address field.

Enter the common part of your 
display computer’s IP addresses.

Determines the fade rates for the 
Standby command.

Enables external control of the 
production computer (for example, 
TOUCHDOWN remote control).



mputers. This setting lets 
e frame rate of any video being 
evices. Your display computers 
3 for more information).

 standby command (page 119).

th the center of the image when 
dow. See “Anchor Position” on 

roduction software. This allows 
from TOUCHDOWN or other 
tocols has provisions for 
tion, as well as other miscella-

 on page 181.

the display cluster control capa-
r Protocol”. While they both 

duction computer and the other 
t the need for any production 

 with this option selected, the 
 to the display computers. 
the presentation was saved, you 
 the Stage menu in order to 
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Display Framerate Specifies the frame rate used by the display co
WATCHOUT optimize its behavior to match th
used in the presentation, as well as the display d
should use a matching refresh rate (see page 4

Standby Rates Specifies the fade out and fade in rates for the

Center Anchor Automatically If checked, the anchor point will be aligned wi
you drag an image to the timeline or stage win
page 144.

External Control Activates external control of the WATCHOUT p
you to control your WATCHOUT presentation 
computers and control systems. The control pro
positioning, starting and stopping the presenta
neous functions. See “Production PC Protocol”

This control feature is not to be confused with 
bility, described in Appendix E “Display Cluste
perform similar functions, one controls the pro
controls the display computers directly, withou
computer being present during playback.

Go Online Automatically When you open a presentation that was saved
production software will automatically connect
Conversely, if this option wasn’t selected when 
must manually choose the Online command on
control the display computers.
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 edge blend. Although it is possible 
rally not required. The same curve 
 corresponds to the outer (dark) 

st the edge blend in WATCHOUT, 
roperly as described beginning on 

lue numerically, or to change its 
 the edge blend curve from one 

he curve, enlarge the window. To 
 then choose Update on the Stage 

past the specified layer in the time-
below that layer in the Timeline 

mages to appear unaffected by the 
ge used to align projectors to the 
ire alignment image, all the way to 
isely covers the display area.

 a video that fits entirely within the 
 extend into the edge-blended 
ndling this correctly (by playing the 
 this may impair performance, 
simultaneously on adjacent display 
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Edge Blend Curve Drag the round dot to adjust the curve of the
to add more points to the curve, this is gene
is applied to all edges. The left of the curve
edge of the gradient.

▲ IMPORTANT: Before attempting to adju
make sure that the projector is adjusted p
page 176.

Double-click a point to view and edit its va
type. This also allows you to precisely copy
presentation to another.

◆ HINT: For better precision in adjusting t
see the result of your changes, click OK
menu.

No Edge-blend Past Layer Turns off edge blending for images placed 
line. This is indicated by a red divider line 
window.

This is useful in cases where you may want i
edge blend gradient, such as a line-up ima
screen. In this case, you want to see the ent
its edges, to make sure that the image prec

Another use for this feature is when playing
confines of a single display, but which may
zones. While WATCHOUT is capable of ha
video in all intersecting display computers)
particularly if you want to play other videos 
areas.



yer, it won’t be masked by the 
 play it on a single display 
his display).

 the edge blend gradient of its 
pping projectors may be super-
lly add a black box behind the 
 but past the image causing the 

h layer in the Timeline window 
ition” on page 93), in which 
 the corresponding condition is 

conditions.

 with external control of display 
sonalized or Multi-lingual 
eans (see Appendix E “Display 
led layers in WATCHOUT can 
UP; matching texts and other 
n.

s media from enabled layers 
view Options” sub-menu on the 
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By placing such a video past the edge blend la
edge blend gradient, allowing WATCHOUT to
computer only (assuming it fits entirely within t

◆ NOTE: Although the image is unaffected by
display computer, images shown by overla
imposed on it. In this case, you must manua
video, on a layer included in the edge blend
problem.

Enabled Layer Conditions Specifies which layer conditions to enable. Eac
can be associated with a condition (see “Cond
case media on that layer will only appear when
enabled. You can specify any combination of 

Layer conditions are particularly useful together
clusters, either using Dataton PICKUP (see “Per
Audio” on page 84) or other external control m
Cluster Protocol”). For instance, the set of enab
be governed by the language selection in PICK
language-dependent images in the presentatio

◆ NOTE: The Stage window normally preview
only. This behavior is governed by the “Pre
Stage menu.
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ion computer with video input 
 Video” media (see “Live Video” on 
o in the production computer, if 
roduction computer as the “Video 

illustration under “Add Live Video” 

ferences dialog box apply only to 
omputer has its own, independent 
llows you to have different configu-
omputers.

e production computer’s Stage 
view mode in the “Live Video” 
 Doing so still allows you to assign 
isplay computers, while disre-
video input device number in the 
gnore the settings in the “Video In” 
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Video In Associates video input cards in the product
device numbers, subsequently used in “Live
page 61). This allows you to view live vide
desired. It serves the same purpose in the p
In” menu does in the display software (see 
on page 125).

◆ NOTE: The “Video In” settings in the Pre
the production computer. Each display c
assignment of video input devices. This a
rations of capture cards in the various c

If you don’t want to preview live video in th
window, choose the “Thumbnail” stage pre
media item (see “Live Video” on page 61).
video input device numbers for use in the d
garding any setting for the corresponding 
production software. In this case, you can i
section of the Preferences dialog box.



 the current window or currently 

sentation.

wing them to be pasted in else-
another position along the 

ing the copies to be pasted in 
isplay configurations or cues 

esentations in this way, any 
er along with the cues, and will 
ow in the target presentation.

nto the current window.

ontents of the clipboard.

s from the current time position 
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EDIT MENU The Edit menu contains commands applying to
selected objects (for example, displays, cues).

Undo/Redo Reverts recent changes you’ve made to the pre

Cut Transfers selected objects to the clipboard, allo
where. Use this, for example, to move cues to 
timeline, or to another presentations.

Copy Copies selected objects to the clipboard, allow
elsewhere. Use this, for example, to transfer d
between presentations. 

◆ NOTE: When transferring cues between pr
media associated with these cues will transf
be automatically added to the Media wind

Paste Pastes the most recently cut or copied objects i

Clear Removes selected objects without altering the c

Select All Selects all objects in the current window.

Select to End Applies to the Timeline window. Selects all cue
and forward.
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 selected object. This is equivalent 
 the object.

and “Cue Specifications” on 
y items, see page 120.

mber of pixels. Applies to cues and 
e stage positions of media 
Chapter 7     Commands

Specifications Opens the Specifications dialog box for the
to pressing the Enter key or double-clicking

See “Display Specifications” on page 134 
page 141 for more details. For media prox

Move Moves the selected objects by a specified nu
displays. When applied to cues, it moves th
controlled by the cues.

Example specifications dialog 
box for a still image.



hen applied to the Media 
 by specifying the name of the 
ommand operates on the infor-
 the Media window, indicating 

 path to media files after they 
r instance, if you start out with 
 early stage of production, you 
b-folder of the folder containing 
, use the Find/Replace 
ath name (beginning with a ‘/’ 
 the name of a folder located in 

re stored in a folder named 
ork volume named “E:” during 

Replacement text.

Finds/replaces one at a 
time or all at once.

Searches currently 
selected items only.
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Find/Replace Finds and optionally replaces specified text. W
window, this allows you to locate media items
media file, or any part of its path name. The c
mation shown in the “File Location” column of
the relative or absolute path to the media file.

You can use the Replace function to update the
have been moved to another disk or folder. Fo
your media files on a shared server during the
may later want to move all media files into a su
the presentation file. After transferring the files
command to change the absolute part of the p
character) to a relative (that is, beginning with
the same folder as your presentation).

As an example, assume that the media files we
“WATCHOUT/Production1/Media” on a netw

Search text.

Check this box to replace the 
found text.

Distinguishes “Arne” from “arne”.
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s into a folder named “Media” 
UT presentation file. You would 
/Replace dialog box to update all 

 Timeline window. In this case, it 
me or media cues by the name of 

in finding cues using a particular 
 the forward direction from the 
 searched backwards.

traight to a Control cue by pressing 
ply name the cues F1, F2, F3, etc, 
key. See “Using Find and Quick-

mand.

No leading ‘/’ character 
indicates a folder relative 
to the folder containing 
the presentation file.
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production. You have now copied these file
located in the same folder as the WATCHO
then enter the following values into the Find
relevant media paths accordingly.

Finding Cues The Find command can also be used in the
allows you to search for Control cues by na
their associated media. The latter is useful 
media item. The timeline is first searched in
current time position. If not found, it is then

Using QuickFind The QuickFind feature allows you to jump s
a single function key on the keyboard. Sim
and then press the corresponding function 
Find” on page 151 for more details.

Find/Replace Again Repeats the most recent Find/Replace com

A leading ‘/’ character indicates 
an absolute path.

Check to replace.

Choose “All at Once” to change 
all matching items, or “One at a 
Time” to review each change 
before proceeding.



tents of the Stage window.

 Stage window. After adding a 
nter its specifications (see 

hile Online is selected on the 

isplay sizes as shortcuts. You 
ialog box as long as it is 
rface card in the display 

ow. A larger preview gives you 
mages using the mouse.

Stage window. If your source 
ackground, then change to 
und color of the images shown 

e in the Stage window always 
indow. While this is the most 

our way if you want to move an 
 another image. In this case, 
ponding to the image to be 
ow.
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STAGE MENU The Stage menu applies specifically to the con

Add Display Adds a new display of the specified size to the
display, open its specifications dialog box to e
“Display Specifications” on page 134). 

▲ IMPORTANT: Displays can not be added w
Stage menu.

The secondary menu provides some common d
can, however, enter any size in the display’s d
supported by the physical display and the inte
computer.

Preview Scale Determines the viewing scale of the Stage wind
greater precision in positioning displays and i

Background Color Allows you to set the background color of the 
material is hard to see on the default (black) b
another color. This has no effect on the backgro
by the display computers.

Click Selects Frontmost Image When this option is selected, clicking an imag
selects the corresponding cue in the Timeline w
natural behavior in many cases, it may get in y
image that appears partially obscured behind
uncheck this menu option, select the cue corres
moved, then drag the image in the Stage wind
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view in the Stage window. They do 

s that contain the name of the 
. This is sometimes useful when 
 images obscured by other images.

ils of images and video for the 
uality in this mode is very low, its 
aling with numerous very large 

bal thumbnail preview for images 
preview as thumbnails by selecting 
up menu in each cue.

tion thumbnails as video preview. 
erous large video clips playing at 

w of all cues except those explicitly 
).

 the areas inside the displays. This 
f what is actually shown by the 
 it harder to edit the presentation, 
s disappear.

age is dimmed using an opacity 
 manipulate in the Stage window. 

be displayed around such images, 
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Preview Options The items on this sub-menu controls the pre
not affect the display computers.

Wireframe. Displays all images as boxe
media item, rather than showing the image
trying to position images, or to track down

Thumbnails. Uses low resolution tumbna
stage window preview. While the image q
performance is high – particularly when de
images.

◆ NOTE: As an alternative to selecting glo
or video, you can set individual cues to 
“Reduced” on the “Stage Preview” pop-

Video as Thumbnails. Uses low resolu
Speeds up editing of presentations with num
the same time.

Best Quality. Renders high quality previe
set to “Stage Preview: Reduced” (page 143

Masked by Displays. Masks images to
provides a more accurate representation o
display computers. However, it also makes
since images positioned outside the display

Outline Dimmed Images. When an im
tween track, it may become hard to see and
Selecting this option causes a thin frame to 
making them easier to see.



d, the Stage window will show 
le in standby mode (that is, any 
rmal/In Standby” on page 92). 
e Stage window.

o see the normal images in the 
 order to preview and possibly 
e standby images. This can be 
ndby Layers” menu item.

. These three menu items 
conditional layers appear in the 
nd “Enabled Layer Conditions” 
al layers.) Generally, you want 
 appear in the Stage window, 
onditional Layers”. To preview 
of whether or not they are 
All Conditional Layers”.

y computers. Once connected, 
mp around on the timeline and 

plays in the Stage window. You 
y changes in the Stage window.

w indicates failed connection to 
Display Computers” on page 
 window.
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Preview Standby Layers. When activate
the same images as the display computers whi
images from standby layers – see “Perform No
This allows you to edit such images through th

However, in most cases, you probably prefer t
Stage window even while in standby mode, in
edit those while the display computers show th
accomplished by un-checking the “Preview Sta

No / All / Enabled Conditional Layers
control to what extent images originating from 
Stage window. (See “Condition” on page 93 a
on page 110 for more information on condition
images originating from enabled layers only to
which is accomplished by choosing “Enabled C
images from all conditional layers, regardless 
enabled in the Preferences dialog box, select “

Online Connects the production computer to the displa
the display computers will follow you as you ju
start/stop the presentation.

◆ NOTE: Choosing “Online” also locks all dis
must deselect “Online” in order to make an

A stop sign inside a display in the Stage windo
that display computer (see “Connecting to the 
81). Other errors are reported in the Message
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ith any changes you’ve made to the 
 modified media files to the display 

ck, or to the image of any standby 
n page 92). Also fades the audio. 
mooth way – possibly to jump to 
e command again to restore 

dby mode, an indicator is shown at 

dby command can be set in the 
Chapter 7     Commands

Update Updates all connected display computers w
presentation, including transferring new or
computers.

Standby Causes all display computers to fade to bla
layer (see “Perform Normal/In Standby” o
Useful if you want to pause the show in a s
another position along the timeline. Give th
normal image display. While online in stan
the top of the stage window.

The fade-out and fade-in times for the Stan
Preferences dialog box (page 107).



tents of the Media window, and 
lected.

file to be added to the Media 
 the Media, Stage or Timeline 

. Use a proxy to handle media 
 the Media window, as 
ge 67. 

roxy being added.
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MEDIA MENU The Media menu applies specifically to the con
is only available when the Media window is se

Add Media File Opens a dialog box where you can choose a 
window. Alternatively, simply drag the file into
window.

Add Proxy Adds a proxy media item of the kind specified
that can not be added simply by dragging into
described under “Using Media Proxies” on pa

Available options vary based on the kind of p
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ng image media only. Check this if 
bed under “Pre-splitting Large 
ing files must be placed in a folder 
r must contain one file per display 
r its target display.

ovie called “LargeMovie.mpg” that 
and “Display 2”. You would then 
e files “Display 1” and “Display 2” 
ie.mpg”. Finally, specify that folder 

r Windows Media files, always 
name of the folder containing the 
bove. This is needed to ensure that 
 used. Note, however, that the indi-
e corresponding displays – and 
ended. By default, Windows may 

w file extensions, choose “Folder 
s Explorer, click the View tab, and 
 types”.

lit or Multiple Displays” is selected, 
ecify the file or folder associated 
ose” button next to the field to 
 Transfer” to “Manual”, you would 
e that may not exist on the produc-
lly to the display computer.

 manually or automatically from the 
ers. Normally, you would choose 
Chapter 7     Commands

Pre-split for Multiple Displays This option applies to video and other movi
you have pre-split a large movie, as descri
Movies” on page 56. In this case, the result
specified in the File/Folder field. This folde
intersecting the movie, each file named afte

As an example, assume you have a large m
intersects two displays named “Display 1” 
pre-split the movie into two files. Name thos
and put them in a folder named “LargeMov
in the File/Folder field of the video proxy.

◆ IMPORTANT: When using MPEG, AVI o
append the proper file extension to the 
pre-split files, as shown in the example a
the correct video playback mechanism is
vidual files must be named exactly as th
must not have a file name extension app
not display filename extensions. To sho
Options” on the Tools menu in Window
uncheck “Hide extensions for known file

File/Folder The title of this field reads “Folder” if “Pre-sp
otherwise it reads “File”. In this field you sp
with the media item. You can use the “Cho
choose an existing file/folder. If you set “File
instead type the fictive, relative path to a fil
tion computer, but will be provided manua

File Transfer Specifies whether the file will be transferred
production computer to the display comput

◆ NOTE: Pre-split movies 
don’t play in the Stage 
window. A placeholder 
thumbnail is displayed 
instead.



 file is to be provided later, 
 not yet available. 

OUT will make sure that the file/
closing the dialog box. If you 
ibility to provide the file, and 

ith this proxy will be transferred 
 Update Stage command, 
ommand. This is particularly 
tion “Update Show” in GUIDE-
be updated without having to 
R Handbook” for details).

ia files must maintain their orig-
y making the original larger 

nges.

to moving images (video) and 

present the proxy in the Media 
 preview. If not specified, a 

and moving images. 

ns transparent areas, as well as 
TCHOUT determines this from 
g a proxy, you must specify this 
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“Automatic”. You may choose “Manual” if the
directly to the display computer, or if the file is

◆ NOTE: If you choose “Automatic”, WATCH
folder you specified actually exists prior to 
choose “Manual”, it becomes your respons
WATCHOUT will not verify its existence.

Auto-Refresh on Update If selected, an updated media file associated w
to the display computers whenever you use the
without first having to use the Refresh Media c
useful in conjunction with the WATCHOUT Ac
MAKER, since it allows selected media files to 
first update the show itself. (see “GUIDEMAKE

▲ IMPORTANT: When using this feature, med
inal size. If required, you can plan ahead b
than necessary to accommodate future cha

Duration Enter the duration of the media here. Applies 
sound only. 

Thumbnail Allows you to choose a thumbnail image to re
window, inside cues and in the Stage window
default icon will be displayed.

Dimension Specifies the size of the image. Applies to still 

Transparency Allows you to specify whether the image contai
the form of transparency used. Normally, WA
the information in the media file, but when usin
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 the image to display without trans-
oving images.

ATCHOUT includes:

 channel.

ation affects the alpha channel of 

ency affects both the alpha channel 
ixels in fully transparent areas are 
duced for printing purposes.

ncy affects both the alpha channel 
ixels in fully transparent areas are 
duced for video compositing 

e image of what appears on a 
an be used to show Excel graphics, 
ar software applications, as part of 

er’s screen is sent continuously via 
mputers, where WATCHOUT 
le, you can put a plain Powerpoint 
on background, thereby enhancing 
abilities of WATCHOUT.

ferred to as a “remote computer”) 
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manually. Setting this incorrectly may cause
parency or not at all. Applies to still and m

The types of transparency supported by W

• None. The image or video has no alpha

• Straight Alpha. The transparency inform
the image only.

• Pre-multiplied with White. The transpar
and the pixels in the image so that the p
white. This is often used in material pro

• Pre-multiplied with Black. The transpare
and the pixels in the image so that the p
black. This is often used in material pro
purposes.

Add Remote Computer This feature allows you to incorporate a liv
computer's screen into WATCHOUT. This c
Powerpoint slides, a Web browser, or simil
your presentation.

The image displayed on the source comput
the network to the WATCHOUT display co
composites it with other media. For examp
presentation on top of a large, high-resoluti
it with all the high-quality presentation cap

To incorporate such a computer display (re
into your presentation, follow these steps:



oftware on the remote computer 

 Media list using this command 
ed below.

Media list onto the Stage, and 
element.

ities as other images. For 
nd opacity. Since the images 
uters, you can show the 
uters.

 number of the remote computer 
 into the Password field. Set 
 server (reducing the resolution 
ance).

erally be set to zero. It may be 
r software which support 

eview the Remote Computer in 
Otherwise, set this to “Thumb-
iew only – not what’s shown by 

uire a WATCHOUT license key.
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• Install, activate and configure VNC server s
(see “VNC Server Software” on page 36).

• Add a Remote Computer media item to the
on the Media menu. Configure it as describ

• Drag the remote computer object from the 
program it using cues as any other image 

A remote computer supports the same capabil
instance, you can program its position, scale a
are sent across the network to all display comp
computer display across multiple display comp

Remote Computer Settings In the Remote Computer dialog box, type the IP
into the Address field, and the VNC password
Dimensions to the size of the display of the VNC
of the Remote Computer may improve perform

The Screen field is rarely used, and should gen
used with some implementations of VNC serve
multiple screens or work-spaces.

Set “Stage Preview” to “Live” if you want to pr
the Stage window of the production software. 
nail”. This setting affects the Stage window prev
the display computers.

◆ NOTE: The Remote Computer does not req
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, such as a camera feed, as part of 
eo feed must be connected to each 
t. For instance, if you want to show 
nal must be fed to both display 
ibution amplifier). See “Live Video 
 details.

ese steps:

the display computer.

.

t your video input device is associ-

ut. 
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Add Live Video This feature allows you to display live video
your WATCHOUT presentation. The live vid
display computer that is expected to show i
live video across two displays, the video sig
computers (for example, using a video distr
Input” on page 153 and page 34 for more

To activate the Live Video feature, follow th

• Start WATCHOUT display software on 

• Press Ctrl-W to switch to Window mode

• On the “Video In” menu, make sure tha
ated with the desired device number.

• Connect a video source to the video inp

Associate a video input device 
number with your video input(s).

Video inputs available on the 
display computer appear here.



ollows:

 list using the command on the 
elow. 

list onto the Stage, as any other 

deo played from disk, allowing 
 opacity. 

u must connect the video signal 
re, this video signal must be 
h display computer that is to 
for more details.

 Device” to the device number 
llustration on page 125. Set the 
priate for your video connection 
ultiple inputs for the same kind 
 field to the right if the “Signal 

t FireWire inputs, this kind of 
eWire video feed introduces a 
s well as reducing performance 
pression.

 video cameras uses an inter-
esenting such a video signal on 
eo projector or other display 
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To use Live Video in your presentation, do as f

• Add a Live Video media item to the Media
Media menu, configuring it as described b

• Drag the Live Video object from the Media 
media object.

Live Video supports the same capabilities as vi
you to program its position, scale, rotation and

To show live video across multiple displays, yo
to each of those display computers. Furthermo
associated with the same input number on eac
display it. See “Live Video Input” on page 34 

Live Video Settings
In the Live Video Media dialog box, set “Input
selected on the “Video In” menu shown in the i
“Signal Input” and “Video Standard” as appro
and source. If your video input interface has m
of signal, enter the desired input number in the
Input” pop-up menu.

◆ NOTE: Although WATCHOUT does suppor
signal is generally not recommended. A Fir
significant delay in the video processing, a
and image quality due to the DV data com

Deinterlacing. Video originating from most
laced signal, just like a PAL or NTSC TV set. Pr
a non-interlaced display device, such as a vid
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, results in visual artifacts often 
 of moving objects. Use the Deinter-
 or “Best Quality” to rectify this 

ess necessary. Some video material 
“progressive scan” mode do not 
duce the image quality.

nt to preview the Live Video in the 
Otherwise, set this to “Thumbnail”. 
w only – not what’s shown by the 

the Stage window of the production 
ed with appropriate video capture 
w. Set the input associations for the 
 “Video In” on page 111).

l sometimes contain noise. These 
 of the edges of the video image to 

he dimensions are fixed by the 
” on the “Video Standard” pop-up 
dimensions. Use this, for example, 
ht into WATCHOUT using a DVI or 

ny edge trimming. For example, if 
ou trim 10 pixels at each edge, the 
0.
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device designed to be used with computers
referred to as “combing” around the edges
lacing pop-up menu, set to “Good Quality”
problem when required. 

▲ IMPORTANT: Do not use this feature unl
and some cameras that can be set to a 
need deinterlacing, and using it may re

Stage Preview.  Set to “Live” if you wa
Stage window of the production computer. 
This setting affects the Stage window previe
display computers.

◆ NOTE: In order to preview Live Video in 
computer, this computer must be equipp
cards, fed with the video signal to previe
production computer in Preferences (see

Trim Edges. The fringes of a video signa
four fields allow you to selectively trim each
remove such noise.

Dimensions. For most video standards, t
standard. However, when selecting “Other
menu, you can manually enter the desired 
to enter the size of a computer signal broug
VGA capture card (see page 153).

◆ NOTE: The dimensions shown are after a
the original image is 640 by 480 and y
resulting dimensions become 620 by 46



devices. The number of video 
pends on your computer hard-

ors – often for different kinds of 
ideo). You specify which one to 
ore Live Video media objects to 
nerally, you can only display 
thermore, it’s generally not 
om one signal to another on the 
 of seconds between the end of 
 of the cue displaying the other.

ing you to group related media 
window is independent of the 
s a means to organize items in 
128 Chapter 7     Commands

Using Multiple Video Inputs WATCHOUT supports up to eight video input 
inputs that can be displayed simultaneously de
ware, type of video input device, etc.

Most video input devices have multiple connect
video signals (for example, Composite and S-V
use in the Live Video media dialog box. Add m
access different inputs on the same device. Ge
one input at a time from any given device. Fur
possible to make a clean switch back-to-back fr
same input device. You need to leave a couple
the cue displaying one input and the beginning

New Folder Adds a new folder to the Media window, allow
items. Any such group of media in the Media 
folders on your hard disk, and serves merely a
the Media window.
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ng their information from the 
d allowing you to refresh only 

.

w (that is, media items not used by 
 can choose Clear on the Edit menu 

indow only. It does not remove the 
mputer.
Chapter 7     Commands

Refresh Refreshes items in the Media list by reloadi
associated media files. A dialog is displaye
media that has been changed or all media

Select Unused Selects all unused items in the Media windo
any cue). After reviewing the selection, you
to remove the unused media items.

◆ NOTE: Doing so cleans up the Media w
corresponding media files from your co



ontents of the Timeline window 
w is selected.

ected layer. When reached 
rammed action. See “Control 

 layer rather than mixing them 
find and prevents them from 

meline, or choose “Insert Layer” 
yer. Choose “Delete Layer” to 

es can not be deleted.

 the layer as well as set various 
s” on page 92 for more details.

tationary while manipulating 
is reflected by the color of the 

cator in the Timeline window 
 points as you drag them.

 mutually exclusive. In order to 
irst deselect “Click Jumps to 
ime” implicitly disables the 
ator.
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TIMELINE MENU The Timeline menu applies specifically to the c
and is only available when the Timeline windo

Add Control Cue Adds a Control cue at the current time and sel
during playback, the cue will perform its prog
Cue” on page 150 for full details.

◆ HINT: When using Control cues, dedicate a
with other cues. This makes them easier to 
getting obscured by other cues.

Adding and Removing Layers Choose “Add Layer” to append a layer to the ti
to insert a layer above the currently selected la
delete the current layer. A layer containing cu

Layer Settings Opens a dialog box that allows you to rename
layer attributes. See “Layer Name and Attribute

Click Jumps to Time Deselect this option to keep the time position s
cues and tween points. The state of this mode 
current time indicator, as shown below.

Snap to Current Time Select this option to make the current time indi
“magnetic”, attracting nearby cues and tween

◆ NOTE: The two modes described above are
activate “Snap to Current Time” you must f
Time”. Likewise, selecting “Click Jumps to T
magnetic behavior of the current time indic
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“Snap to Current Time” modes 
lor of the current time indicator:

ition” field takes you to that precise 
ying to click a specific time in the 

Snap to Current Time.

Attracting a cue or tween point.
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The state of the “Click Jumps to Time” and 
described above is also indicated by the co

Timeline Settings Displays the Timeline Settings dialog box.

◆ HINT: Typing a value into the “Time Pos
time. This is often more accurate than tr
time ruler.

Click Jumps to Time.

Click Jumps to Time inactive.

Jump to specified time position.

Total duration of your presen-
tation. Extended automatically 
as more cues are appended.



 is selected. It allows you to add 
can be removed by unchecking 

enu vary depending on the 
weening is only available for 

acks on page 145.
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TWEEN MENU The Tween menu is available when a media cue
tween tracks to the cue. Likewise, tween tracks 
the corresponding item on the Tween menu.

◆ NOTE: The items available on the Tween m
selected media cue. For instance, Volume t
sounds and movies – not for still images.

Read more about the various kinds of tween tr
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8

 wall cubes and plasma screens. 
lays properly, as described on 
y technologies on page 169. 

ose “Add Display” on the Stage 
splay sizes. The size of the display 
y Specifications” dialog box 

ct multiple displays. Alternatively, 
e the selection rectangle. To de-
 in the Stage window.

ow before you can select displays. 
le bar. Displays can not be manipu-
ctive.

g the mouse. Press the Shift key 
to horizontal or vertical only. For 
g the “Display Specifications” 

ose “Cut” or “Clear” on the Edit 
hen paste the duplicate back into 
, keep in mind that the duplicate 
Chapter 8     Displays

8 DISPLAYS

Displays include projectors, monitors, video
You need to install and configure your disp
page 33. Read more about different displa

Adding Displays To add a display to the Stage window, cho
menu. This menu includes most standard di
can be altered afterwards using the “Displa
(page 134).

Selecting Displays Click a display to select it. Shift-click to sele
drag from a point outside all displays to us
select all displays, click outside all displays

◆ NOTE: You must activate the Stage wind
To activate the Stage window, click its tit
lated if “Online” on the Stage menu is a

Positioning Displays Drag a display to the desired position usin
while dragging to constrain the movement 
best precision, enter the exact position usin
dialog box (page 134). 

Removing and Duplicating Displays To remove a display, first select it, then cho
menu. To duplicate it, first choose “Copy” t
the Stage window. When pasting a display



 Stage window as the original 
ation and change its name and 

, first select the display in the 
 the Edit menu, or simply 

 can select displays. To activate 
an not be manipulated if 

ntify pre-split movie files, as de-
on page 56. Thus, if you use 
e the name of the display after 
ame the movies accordingly.

lay computer that manages this 
f the display. However, if the 
ans of a Domain Name Server), 
ad.

are on the same subnet, which 
is identical, and only the last 
ation on page 40). In this case, 
art of the IP address in Prefer-
e 107), and then enter only the 
ions dialog box. For instance, if 
u would put “192.168.0.” into 
134 Chapter 8     Displays

initially occupies the exact same location in the
did. You must move the duplicate to another loc
address before using it.

DISPLAY SPECIFICATIONS To open the Display Specifications dialog box
Stage window then choose “Specifications” on
double-click the display.

You must activate the Stage window before you
the Stage window, click its title bar. Displays c
“Online” on the Stage menu is active.

Name. Specifies the name of the display. 

▲ IMPORTANT: This name is also used to ide
scribed under “Pre-splitting Large Movies” 
such pre-split movies, you should not chang
creating those movies, or you’ll have to ren

Address. Specifies the IP address of the disp
display. This is typically the numeric address o
display computer is accessible by name (by me
you may enter the DNS name in this field inste

◆ HINT: In most cases, all display computers 
means that the first part of their IP address 
group of digits differ (as shown in the illustr
it’s more convenient to enter the common p
ences (see “Display Address Prefix” on pag
last group of digits in the Display Specificat
the complete address is “192.168.0.51”, yo
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ferences (note the trailing period), 
n “Display Specifications”.

he on-line status of the associated 
nection” button to verify the ability 

er. This can be useful when trouble-

ge the color of the display’s outline 
 for overlapping displays makes it 

the dimension and position of the 
 any display size. However, the 
ined by the display device and 
en using the system, each display 
ified size, displaying a message in 

ary angle. This allows you to use a 
ative display arrangements as 
 Display Layouts” on page 10.

his field is similar to the Left and 
 field above, but indicates the 
r. The center position is often more 
itrary angle.
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the “Display Address Prefix” field in Pre
and then put 51 into the Address field i

Peer and Test Connection. Indicates t
display computer. You can use the “Test Con
to connect to that particular display comput
shooting a system.

Color and Change. Allows you to chan
in the Status window. Using different colors
easier to tell them apart.

Size and Stage Position. Determines 
display. WATCHOUT allows you to specify
allowable dimensions are ultimately determ
display card in each display computer. Wh
computer will ensure that it’s set to the spec
case of any discrepancies. 

Rotation. Rotates the display to an arbitr
vertical display format, as well as other cre
shown in the illustration under “Alternative

Stage Position of Display Center. T
Top fields in the “Stage Position of Display”
center position rather than the top left corne
useful when the display is rotated to an arb



 errors caused by projection off-
inor optical distortion.

 a flat surface always gives the 
hen absolutely necessary.

he keystone-shaped image 
pective on the Correction pop-

 until the image appears rectan-

y dialog box to see the changes 

. Adds bezier handles to the 
g you to compensate for projec-
).

 corners, allowing you to 
associated with wide-angle 

ox show values associated with 
 each numeric field adjust the 
eckbox interlocks the direction 
136 Chapter 8     Displays

GEOMETRY CORRECTION These settings allow you to compensate for any
axis (perspective), on a curved surface or for m

◆ NOTE: Projecting straight from the front on
best image. Use geometry correction only w

Perspective Correction. Compensate for t
caused by off-axis projection by choosing Pers
up menu and dragging the corners of the grid
gular on screen.

◆ HINT: Go online before opening the Displa
on screen as you make them.

Horizontal, Vertical or Full Correction
top/bottom, left/right or all four sides, allowin
tion on a curved surface (see illustrations below

Corner Shapes. Adds bezier handles to the
compensate for minor optical distortion, often 
lenses (as exemplified on page 179).

The numeric fields at the bottom of the dialog b
the currently selected point. The buttons next to
value with single pixel accuracy. The “Lock” ch
handles, resulting in symmetric curvature.

Examples of screens requiring hori-
zontal, vertical and full correction 
respectively.
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9

. They control when media appear 
r such as positioning and opacity. 
. The layers determine the back-to-

dow, drag a Media window item, 
ndow. Media files can be dragged 

all media used in a presentation in 
 show file. Doing so allows 
relative path specification, making 
ll its media references intact.

ow, the cue will appear on the 
d line under the layer’s name) and 
 into the timeline, the cue appears 

ultiple cues. Alternatively, drag 
ction rectangle. Use “Select All” on 
. To de-select all cues, click in the 
ndow.
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9 CUES

Cues are the active objects of WATCHOUT
on stage, as well as more dynamic behavio
Cues exist on layers in the Timeline window
front stacking order of media on stage.

Adding Cues To add a cue to a layer in the Timeline win
or a media file, to the layer or the Stage wi
directly from your hard disk.

▲ IMPORTANT: Whenever possible, keep 
a sub-folder of the folder containing the
WATCHOUT to refer to the file using a 
it easier to move the presentation with a

When you drag media into the Stage wind
currently selected layer (as indicated by a re
at the current time position. When dragging
at the layer and time you drag it to.

Selecting and Positioning Cues Click a cue to select it. Shift-click to select m
from a point outside all cues to use the sele
the Edit menu to select all cues on all layers
white space of any layer in the Timeline wi



w image in the Stage window. 
ponds to a particular image on 

mouse. To drag cues to another 
s the Shift key while dragging. 

, go to the desired time position 
31), then paste it. Alternatively, 
ns” on page 141).

rd to select the next or previous 
 Shift key as well selects the next 
and down arrow keys changes 

ove or copy cues within a 
lipboard. When transferring 
dia associated with those cues 
ntation.

lipboard, select the cues then 

ill appear on stage. To change 
the Stage window. You can 
e same time by first selecting 
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You can also select a cue by clicking its previe
This allows you to determine which cue corres
stage.

To position selected cues, drag them using the 
layer without altering their time positions, pres

If you want to position a cue numerically, cut it
using the Timeline Settings dialog box (page 1
use the cue’s dialog box (see “Cue Specificatio

Selecting Cues using the Arrow Keys Press the right or left arrow keys on the keyboa
cue on the currently selected layer. Pressing the
or previous cue on any layer. Pressing the up 
the currently selected layer.

Cutting, Pasting and Deleting Cues Use Cut, Copy and Paste on the Edit menu to m
presentation or to other presentations via the c
cues to other presentations in this way, any me
will automatically be added to the target prese

To delete cues without altering the content of c
choose “Clear” on the Edit menu.

Changing a Cue’s Media Position 
On Stage

Cues contain information on where the media w
the stage position, drag the preview image in 
change the stage position of multiple cues at th
those cues.
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een points, click the desired tween 
he image. If the timeline isn’t posi-
, a new point will be added.

own numerically in the Position 
ge” on page 69). For precise 
 the Shift key to move in greater 

of multiple cues using the Move 
ly useful when merging cues from 
.

ag the bar at either end of a cue. If 
ult remain stationary in relation to 
h the cue, press the Alt key while 

he current time position if “Snap to 
).

ed duration into the cue’s dialog 
).

oving image beyond its natural 
der using the last frame of the 
movie run repeatedly in a loop by 
p” on page 143).
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▲ IMPORTANT: If a cue has any Position tw
point to go to its time before dragging t
tioned exactly at a Position tween point

The stage position of the anchor point is sh
tween track (see “Positioning Media on Sta
adjustments, press Control-arrow key. Add
steps. 

◆ HINT: You can move the stage position 
command (page 113). This is particular
shows having different display positions

Changing a Cue’s Duration To change the duration of selected cues, dr
the cue has tween points, those will by defa
the timeline. To stretch the tween points wit
dragging the end of the cue. 

◆ HINT: Either end of the cue will snap to t
Current Time” is selected (see page 130

To set the duration precisely, type the desir
box (see “Cue Specifications” on page 141

◆ NOTE: If you extend the duration of a m
duration, it will by default fill the remain
movie. Alternatively, you can make the 
choosing the “Loop” behavior (see “Loo

Drag either end to change the 
duration of all selected cues.



g new media onto the cue. You 
, or a new media file from your 

f a certain media file, you can 
e Media window instead, as 
tion” on page 95. Doing so will 
em.
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Replacing a Cue’s Media To change the media associated with a cue, dra
can drag either an item from the Media window
hard disk.

◆ HINT: If you want to replace all instances o
change the file association of the item in th
described under “Changing the File Associa
affect all cues associated with that media it
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 options available vary with the 
 To open a cue’s specifications 
cifications” on the Edit menu, or 

Indicates how long the media 
remains visible on stage.

Media will be pre-rolled auto-
matically (uncheck to specify 
pre-roll time manually).

Loop sound or movie when cue 
is extended past media’s 
natural duration.

Locates associated item in the 
Media window.

Calculates top-left or center 
position for anchor point.
Chapter 9     Cues

CUE SPECIFICATIONS Specifies the settings of the current cue. The
kind of media that is controlled by the cue.
dialog box, select the cue and choose “Spe
simply double-click the cue.

The time when the media will 
appear on stage.

Starting offset into sound or movie.

Continue to play even if timeline 
stops.

Controls the stage window 
preview quality of this cue.

Position of anchor point within 
image, relative to image’s top left 
corner.



prepared a few seconds ahead 
is time is calculated automati-

ses.

ickTime movies) may require 
 This may cause already visible 
idable, you may be able to 
n the preparation occurs back-

re-roll indicator appears in the 
y dragging the start of this indi-
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Pre-Roll Sound and video needs to be pre-loaded and 
of its appearance. When set to “Automatic”, th
cally. This is the appropriate setting in most ca

However, certain media files (most notably Qu
extensive computer resources when prepared.
moving media to suffer. Although this is unavo
reduce the impact by moving the moment whe
wards to a more appropriate time.

When specifying the pre-roll time manually, a p
timeline window. You can set the pre-roll time b
cator.

Pre-roll indicator. Drag to change 
pre-roll time.
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ovie. For example, a certain movie 
ning. To skip over those ten 

rt from its beginning) when played 
r short, cyclical animations, where 

.

, the duration of the cue must be 
tion.

 play even if the timeline is paused. 
t or conference situations, where 
While waiting at a pause cue, you 
usic or a video clip playing.

viors can be combined to create 
ideo of undetermined duration. 

iew quality. Set to “Reduced” to 
o “None” to suppress preview alto-
lity”, the name of the cue is shown 

ity is ultimately determined by the 
menu (see “Preview Options” on 
maximum quality by which the cue 
Chapter 9     Cues

In-Time Specifies a starting offset into a sound or m
may have ten seconds of black at the begin
seconds, set the in-time to 10.

Loop Causes sound or movie media to loop (re-sta
past its duration. This is particularly useful fo
the movie then contains only a single cycle

◆ NOTE: To see the effect of this behavior
extended past the media’s natural dura

Free Running Causes sound or movie media to continue to
This is particularly useful in speaker suppor
you may be cueing the timeline manually. 
may still want to have some background m

◆ HINT: The Free Running and Loop beha
continuous playback of sound and/or v

Stage Preview Controls the maximum Stage window prev
preview the image using its thumbnail. Set t
gether. When set to anything but “Best Qua
in italics to indicate this.

◆ NOTE: The Stage window preview qual
“Preview Options” setting on the Stage 
page 117). The cue setting specifies the 
will be previewed.



lative to the upper left corner of 
layed as a crossed circle in the 
age, the anchor specifies the 

low shows the behavior of an 
int.

 box determines the initial posi-
“Center Anchor Automatically” 
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Anchor Position Determines the position of the image anchor, re
the image. The anchor of a selected cue is disp
Stage window. When scaling or rotating an im
point that remains stationary. The example be
image scaled relative to a centered anchor po

◆ HINT: A checkbox in the Preferences dialog
tion of the anchor point for new cues. See 
on page 108.

Scaling and 
rotating an image 
around its anchor 
point.
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rance of media on stage over time. 
 with the cue, you can add one or 

ges.

ges.

s.

ges.

mages with embedded audio.

ween track. See “Tween Tracks” on 
een tracks in general.
Chapter 9     Cues

TWEEN TRACKS Tween tracks allow you to control the appea
Depending on the type of media associated
more of the following tween track types:

• Opacity, applies to moving and still ima

• Position, applies to moving and still ima

• Scale, applies to moving and still image

• Rotation, applies to moving and still ima

• Volume, applies to audio and moving i

The following pages describe each kind of t
page 73 for more details on how to use tw

To add or remove a tween track, 
first select the cue then choose the 
desired type on the Tween menu.

Tween tracks appear in the tween 
pane, occupying the lower 
portion of the Timeline window.



e. To change the opacity, either 
ck, or double-click it to change 
76 for more details.

of the tween point along the 
an occupied by the cue. 

 a corner point into a smooth 

n the cue’s body, allowing you 

 video containing audio. Its 
en point, described above. See 

 the body of a cue assigned to 
e curve even when the cue isn’t 
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Opacity Controls the opacity (transparency) of an imag
drag the tween point vertically in the tween tra
its value numerically. See “Opacity” on page 

The “Time Position” field specifies the position 
timeline. This must be a time within the time sp

The “Smooth” checkbox allows you to change
point, and vice versa. 

◆ HINT: The opacity curve is also displayed i
to see it even when the cue isn’t selected.

Volume Controls the audio volume of audio media and
behavior is identical to that of the Opacity twe
“Volume” on page 76 for more details.

◆ HINT: The volume curve is also displayed in
an audio media item, allowing you to see th
selected.
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sition (see “Anchor Position” on 

tive to the image’s natural size), or 
gative values flip the image.

track to reduce the size of large im-
isplay). Use an image editing ap-

tead. Using WATCHOUT’s scaling 
impair performance.

alues, first uncheck the “Maintain 
Chapter 9     Cues

Scale Scales an image in relation to its anchor po
page 144).

You can specify either the scale factor (rela
the desired size of the image on stage. Ne

▲ IMPORTANT: Do not use a Scale tween 
ages (significantly larger than a single d
plication, such as Adobe Photoshop, ins
capability to reduce large images may 

To scale the width and height by different v
Proportions” checkbox.

As an alternative to the Scale 
dialog box, simply drag the 
scaling handle. Press Shift to 
maintain the image’s propor-
tions as you drag.

Non-uniform scaling results in a 
split scale curve, allowing you to 
adjust horizontal and vertical 
scaling independently.



sition, drag the image or one of 
indow when the cue is selected. 
e Position tween point and type 
e “Location” field.

 select all the Position tween 
ve command on the Edit menu. 

 into or out from the point. A 
 to move linearly to the next 
r and greater values go faster. 
 the motion path, as shown 
age 79.

curved motion paths, as shown 
 80. When selected, a direction 
ng the direction of motion into 
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Position Positions an image on stage. To change the po
the motion path handles shown in the Stage w
To set the position numerically, double-click th
the desired position of the anchor point into th

◆ HINT: To move the entire motion path, first
points, then drag the image. Or use the Mo

The “Speed” fields control the speed of motion
value of 1 results in the normal speed required
point. Smaller values make the image go slowe
The speed is indicated by the white dots along
under “Controlling the Speed of Motion” on p

Moving along a Path The “Smooth” checkboxes allow you to create 
under “Moving Along a Curved Path” on page
handle appears attached to the point, controlli
or out from the point.

Smooth Position tween points 
create a curved path.

White dots along the motion path 
indicate the speed of motion.
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see “Anchor Position” on page 
ied number of revolutions or 
example, to rotate 2.5 times, set 

e Stage window or the Rotation 

en underneath the anchor point. If 
nchor Position” on page 144), or 

the angle.

ging a 
n point.
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Rotation Rotates an image around its anchor point (
144). You can rotate the image by a specif
degrees, or a combination of the two. (For 
Revolutions to 2 and Degrees to 180.)

Alternatively, drag the rotation handle in th
tween point in the tween pane.

◆ NOTE: The rotation handle may be hidd
so, either move the anchor point (see “A
drag the Rotation tween point to adjust 

Rotate by dragging 
the rotation handle…

…or by drag
rotation twee

Anchor 
point.



eline. The cue is performed 
an be used to make the timeline 
 by name).

ps – causing a section of the 
ave the option of automatically 
se, it is often a good idea to 
e display computers to catch up 
-Run Delay” field.

described on the next page, 
and (see “Standby” on page 

Makes timeline jump to a 
time position or a named 
Control cue.

Jumps backwards only 
when jumping to a named 
cue.

Introduces a delay between 
the jump and re-start, 
giving display computers 
time to respond.
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CONTROL CUE The Control cue governs the behavior of the tim
when the timeline runs past it. The Control cue c
pause, or jump to another position (by time or

You can use the “Jump to” option to create loo
timeline to be repeated. When jumping, you h
restarting the timeline after the jump. In this ca
introduce a delay of a second or so to allow th
before starting. This is done using the “Jump-to

To exit such a loop, use the QuickFind feature 
possibly in conjunction with the Standby comm
119).

Cue name. Used to jump to a 
named position. Name cues F1 
through F12 to use function keys.

Time position or Control cue 
name to jump to.

Makes the timeline to pause or run 
(possibly after jumping). 
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Find command to locate position 
eature allows you to instantly jump 
n keys on your computer’s 
the Control cues “F1”, “F2”, etc, as 

eld is case sensitive. When using 
 F.
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Using Find and QuickFind Named Control cues can be used with the 
along the timeline by name. A QuickFind f
to one of several positions using the functio
keyboard. To use this feature, simply name 
in the example on the previous page.

▲ IMPORTANT: The Control cue’s name fi
function key names, type an upper case
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A

 to install WATCHOUT on a PC.

 minimum system requirements:

t AMD processor.

 slot.

rting DMA transfers.

e hard disk interface.

ke on LAN”.

with 64 MB of video memory.

io support.

hics cards in one display cluster is 

ch display computer for displaying 
 video input, and the appropriate 
Appendix A     System requirements

A SYSTEM REQUIREMENTS

This appendix lists what you need in order

COMPUTER A WATCHOUT computer has the following

• Intel Pentium 4 at 1.5 GHz or equivalen

• USB port.

• Wake on LAN.

• 512 MB of RAM.

• AGP 4X or PCI Express 16X video card

• IDE or SATA hard disk interface, suppo

• 60 GB hard disk fully utilizing the abov

• 100 MBit Ethernet card supporting “Wa

• A modern ATI or nVidia graphics card 

• High quality sound card or built-in aud

• Windows XP Home Edition.

Mixing different kinds of computers or grap
generally not recommended.

LIVE VIDEO INPUT To integrate live video into WATCHOUT, ea
live video must be equipped with a suitable

◆ NOTE: These are minimum 
system requirements. Faster 
processor, faster memory, 
faster hard disk with cache 
memory, faster graphics card 
with more video memory, etc, 
will result in significantly 
increased performance in 
many applications. Some 
functions (for example, live 
video integration) require 
additional hardware.



must be installed. Many devices 
s, while some support more 

bus cards providing video input 
products/osprey.html).

graphics cards with an inte-
nd S-Video signals.

A-style computer inputs (http:/

deo input (http://www.pixel-
card.htm). To use the Pixelmagic 
 their “Sweetspot” driver (http:/
wnloads/software/).

 connected using a TCP/IP 

k ports on all computers and an 
number of ports to connect the 
hernet, although this will slow 
does not, however, have any 
ystem.
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WDM (Windows Driver Model) capture driver 
support multiple Composite and S-Video input
advanced video signal standards.

Suitable video input solutions include:

• Viewcast Osprey 2xx series. These are PCI-
functions only (http://www.viewcast.com/

• ATI All-in-wonder (AIW) series. These are 
grated video input, supporting Composite a

• Datapath Vision RGB-Pro cards provide VG
/www.datapath.co.uk/visRGBPRO.htm).

• Pixelmagic SDI cards provide SDI digital vi
magicsystems.com/products/sdi/capture_
card with WATCHOUT, you need to install
/www.pixelmagicsystems.com/support/do

NETWORK The production and display computers must be
compatible network.

A typical system has 100 MBit Ethernet networ
high-quality Ethernet switch with the required 
computers. It is also possible to use 10 MBit Et
down media file transfers. The network speed 
impact on the runtime timing precision of the s

http://www.pixelmagicsystems.com/products/sdi/capture_card.htm
http://www.pixelmagicsystems.com/products/sdi/capture_card.htm
http://www.pixelmagicsystems.com/products/sdi/capture_card.htm
http://www.viewcast.com/products/osprey.html
http://www.datapath.co.uk/visRGBPRO.htm
http://www.pixelmagicsystems.com/support/downloads/software/index.htm
http://www.pixelmagicsystems.com/support/downloads/software/index.htm
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B.

y computer outlined in Chapter 2 
me computers require additional 
 This section provides some general 

 a WATCHOUT display computer, 
rd disk and then install only 
TCHOUT. This avoids many prob-
that are often pre-installed on 
over time.

r hard disk in order to use 
edure that helps in obtaining the 
ply all other adjustments described 
 to dedicate the computer to 

ake sure that the hard disk doesn’t 
uld perform a backup if you’re 
hen start the computer from the 
creen instructions. Early on in the 

here to install Windows. As part of 
 the existing partitions and create 
Appendix B     Computer Issues

B COMPUTER ISSUES

While the basic configuration of the displa
“Installation” is sufficient in many cases, so
work to achieve best possible performance.
hints and pointers on how to proceed.

DEDICATED COMPUTER If you intend to use a computer primarily as
it probably makes sense to re-format the ha
Windows, required device drivers and WA
lems caused by various pieces of software 
computers, or that may have accumulated 

◆ NOTE: You don’t have to re-format you
WATCHOUT. This is an advanced proc
best possible performance. You can ap
in this appendix even if you choose not
WATCHOUT.

Formatting the Disk and Installing 
Windows

To prepare your computer in this way, first m
contain any important information. You sho
unsure about the content of the hard disk. T
Windows XP CD-ROM, and follow the on-s
installation procedure, you will be asked w
this, you will get the opportunity to remove
new ones, which you should do.



all (10 GB or so) partition for 
y want to install. This partition 
 of the disk un-formatted.

 created, small partition. Once 
phics or sound card drivers, 
entioned in this appendix.

mat the remaining space of the 
strative Tools > Computer 
the list.

 Partition Wizard”, choose the 
ize” of 32K. Generally, it is OK 
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For best performance, you should create a sm
Windows, and any other applications you ma
will become the C: drive. Leave the remainder

Proceed with installing Windows on the newly
that’s done, install required device drivers (gra
etc), and perform any additional adjustments m

Installing WATCHOUT Before installing WATCHOUT, you need to for
hard disk. Choose Start > Programs > Admini
Management, then click Disk Management in 

▲ IMPORTANT: On the last page of the “New
NTFS file system with an “Allocation Unit S
to also select “Perform a Quick Format”.

Right-click on the Unallocated 
space and choose “New Parti-
tion”. Proceed with creating a 
primary partition of the maximum 
size.
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ze greatly reduces the tendency of 
ount of wasted disk space. Given 

tend to be rather large, this should 

artition will appear as the D: disk 
ATCHOUT folder on this disk, and 
staller, as described on page 31. 
e to install WATCHOUT, chose the 
: drive.

 by numerous small programs and 
rograms consume considerable 
se on a WATCHOUT display 
y identifying and removing, or 

lications or services, first close all 
d choose Programs > Accessories 
t “Software Environment, Running 
ht displays all currently running 

ok specifically for tasks whose path 

lly started, choose “Software 
o the left.
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Specifying a larger than usual allocation si
disk fragmentation, at the cost of a small am
the fact that most WATCHOUT media files 
not have any practical disadvantages.

Once the formatting is complete, the new p
drive in the Windows Explorer. Create a W
install WATCHOUT to this disk using the In
When given the opportunity to specify wher
newly created WATCHOUT folder on the D

GENERAL PERFORMANCE The performance of a PC is often degraded
services running in the background. Such p
system resources, and may serve no purpo
computer. You can enhance performance b
disabling, such programs.

Identifying Background Programs To identify any unwanted background app
open windows then click the Start button an
> System Tools > System Information. Selec
Tasks” in the list to the left. The list to the rig
programs (see illustration on page 158). Lo
is anything but “c:\windows\system\...”.

To see which programs that are automatica
Environment, Startup Programs” in the list t



s and Startup Programs lists are 
 with a particular program. In 
 program’s file can provide a 
is installed under “c:\Program 
 by looking inside its installation 
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◆ HINT: The names listed in the Running Task
often cryptic, and may be hard to associate
this case, looking at the path leading to the
valuable hint. In particular, if the program 
Files\...”, you should be able to learn more
folder.
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ckground programs, you should 
 you won’t need a background 

ove Programs” control panel, 
ve...”. Follow the subsequent 
he program.

gram, or if the program doesn’t 
ntrol panel, you may instead 
 done with configuration options in 
ffer this capability, forcing you to 
ing other means.

elves by an icon on the taskbar, in 
lick such an icon to open its menu. 
“Close” or “Do Not Load” item. It 
erties” items that allow you to set 
ding of the program at start-up. 

art the computer to verify that the 
s only allow you to disable them 

ext time you start the computer. 
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Removing Background Programs Once you have identified any undesired ba
either remove or disable them. If you know
program, remove it from the computer.

To remove a program, open the “Add/Rem
choose the program, and click “Add/Remo
instructions on how to remove or uninstall t

If you’re uncertain about removing the pro
appear in the “Add/Remove Programs” co
choose to disable it. This can sometimes be
the program itself. Other programs don’t o
either uninstall the program or disable it us

Background programs often identify thems
the lower right corner of the screen. Right-c
Sometimes the menu includes a “Disable”, 
may include “Open”, “Configure” or “Prop
various options, including the automatic loa
After disabling a program in this way, rest
program is no longer active. Some program
temporarily, and will then load again the n



grams is by using the System 
e Start button and choose Run. 

 the “Startup” tab. You can turn 
ts checkbox.
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Another way to locate and disable startup pro
Configuration Utility. To open this utility, click th
Enter “msconfig” into the Run dialog box. Click
off any undesired startup item by unchecking i
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egular programs, but as System 
services by clicking the Services tab 
vious page). This also lists which 
 not be disabled), as well as the 

 them in the Services tab of the 
se Start > Programs > Administra-

ch service. Select a service in the 
ous services, of which most are not 
g WATCHOUT display software. 
se listed as “Started”. To disable a 
ype” to Disabled.
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System Services Most background activities are not run as r
Services. You can view the installed system 
in the System Configuration Utility (see pre
services that are considered essential (must
manufacturer of each service.

Do not disable any services by unchecking
System Configuration Utility. Instead, choo
tive Tools > Services.

This list provides detailed information on ea
list for a description. The list contains numer
needed on a computer dedicated to runnin
Not all services listed are running – only tho
service, double-click it and set its “Startup T

◆ NOTE: If the “Administrative 
Tools” are unavailable, right-click 
the task bar and choose Properties 
to display the “Taskbar and Start 
Menu Properties”. Click the “Start 
Menu” tab. Click the “Customize” 
button and the “Advanced” tab (if 
available). In the list, make sure 
that “System Administrative Tools” 
(or “Display Administrative Tools” 
if using the Classic Start menu) is 
enabled.



ices do, and which ones you 
 site:

services/print.shtml

g and removing media or other 
 fragmented hard disk signifi-

access and display images and 
optimal working condition. To 
s > Accessories > System Tools 
g your WATCHOUT program 
nter window, and click Defrag-

cation unit size, as described 
6, greatly reduces the tendency 

ons, you should defragment 
e disk into a Windows and a 

 should not need to be defrag-
e.

 disk, do so before you defrag-
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For more information on what the various serv
may disable (or set to “Manual”), visit this web

http://www.techspot.com/tweaks/winxp_

Defragmenting the Disk After using WATCHOUT for some time, addin
files, the hard disk may become fragmented. A
cantly increases the time and effort required to 
video. Defragmenting the disk restores it to its 
defragment your disk, choose Start > Program
> Disk Defragmenter. Select the disk containin
folder in the list at the top of the Disk Defragme
ment.

◆ NOTE: Formatting the disk with a large allo
under “Installing WATCHOUT” on page 15
of fragmentation, but doesn’t eliminate it.

If your computer has additional disks or partiti
those as well. However, if you’ve partitioned th
WATCHOUT partition, the Windows partition
mented very often, since it really doesn’t chang

If you also want to remove old shows from the
ment the disk (see page 82).

http://www.techspot.com/tweaks/winxp_services/print.shtml
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vice Manager” button. 

 item in the list and double click 

set “Transfer Mode” as shown.
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Verify Disk DMA Setting • Open the System control panel.

• Click the “Hardware” tab, then the “De

• Open the “IDE ATA/ATAPI controllers”
“Primary IDE Channel”.

• Click the “Advanced Settings” tab and 

◆ NOTE: Depending on your 
computer’s configuration, type of 
disk drives, etc, your settings may 
be slightly different from those 
shown.



 in computers and graphics 
puter and the graphics card 
e of the more useful utilities 
the graphics card is PowerStrip:

:
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DISPLAY PERFORMANCE WATCHOUT is based on the latest technology
cards. For this to work optimally, both the com
must be properly installed and configured. On
available to verify and control the operation of 

PowerStrip is shareware, and is available from

http://www.entechtaiwan.net/

Verify that basic functionality such 
as AGP and 4x or 8x transfer rate 
is supported by your computer and 
graphics card.

http://www.entechtaiwan.net/
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nd you believe your system should 
puter vendor to see if there’s any 
ctivate those features (for instance, 
te”). Sometimes, the application of 
ost in speed.

splay refresh rate of your computer 
used in WATCHOUT (see “Display 
card, driver software and display 
able to you in Windows. In some 
 This typically happens if the 
er tells the display card that it 

t other refresh rates than the ones 
 control panel. One such program 

.

jector from telling the display card 
he range of allowable settings. This 
DC signal) in the standard, analog, 
ost displays. Use a VGA male-to-

emove pin 12 in either end of the 

 other timing parameters to values 
 damage to certain display types 
check the documentation of the 
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Motherboard Chip Set Updates If some of these features aren’t available, a
support them, you should contact your com
motherboard software update available to a
“Intel chip set update” or “VIA chip set upda
such an update may result in a dramatic bo

Display Refresh Rate Settings For optimal results, it is important that the di
is set at an even multiple of the frame rate 
Framerate” on page 108). Certain display 
combinations may restrict the choices avail
cases, you may not have any choice at all.
display/projector connected to the comput
prefers one particular frequency.

Some utility programs may allow you to se
provided by the standard Windows Display
is PowerStrip, shown on the previous page

Another option is to prevent the display/pro
about its capabilities, and thereby limiting t
can be done by disconnecting pin 12 (the D
15-pin, VGA-style cable, used to connect m
female extension cable and disconnect or r
cable.

▲ CAUTION: Changing the refresh rate or
outside the allowable range may cause
(primarily CRT-based displays). Please 
display for details.

15
10 6

15 11

Female VGA-style connector.



a of computer graphics, the 
r graphics card may be old by 
raphics card vendor’s web site 

rivers.asp

dure for installing/upgrading 
 a ReadMe file, included with 

 perform better, with certain 
. WATCHOUT is compatible 
a standard part of Window XP. 
 from:
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Display Card Drivers Due to the fast pace of development in the are
driver software included with your computer o
the time you receive it. Check the computer or g
for updates:

http://www.ati.com/support/driver.html

http://www.nvidia.com/content/drivers/d

Make sure you follow the recommended proce
the display card driver. This is often covered in
the driver.

DirectX Some display cards and/or drivers require, or
versions of Microsoft’s DirectX system software
with DirectX 7 and later. DirectX is included as 
You can download the latest version of DirectX

http://www.microsoft.com/directx

http://www.nvidia.com/content/drivers/drivers.asp
http://www.microsoft.com/directx
http://www.ati.com/support/driver.html
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 cause problems from time to time.

ed with graphics cards or DVD 
ATCHOUT to play back MPEG2 
 solve this problem, uninstall the 
ents.

er for the sound card installed in 
ur computer, operating system or 
uld check the sound card manufac-
latest driver version installed – 
layback-related problems.

ver software, avoid installing other 
 often provided that will run as 
 check for and remove such soft-
 drivers (see “Removing Back-

be caused by defect software 
nose. More often than not, it’s 
 the hard disk and re-installing 
 (see “Formatting the Disk and 
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OTHER ISSUES This section lists some other issues known to

MPEG2 Playback Some DVD player programs – often includ
drives – may interfere with the ability of W
content (including some audio formats). To
DVD player application and all its compon

Sound Playback You need to install the proper software driv
your computer. The driver received with yo
sound card is usually sufficient, but you sho
turer’s web site to make sure you have the 
particularly if you’re experiencing sound p

When installing or updating sound card dri
associated software. Additional software is
background applications. You may have to
ware after installing/upgrading sound card
ground Programs” on page 159).

Defect Drivers Performance and reliability problems may 
drivers. Such problems can be hard to diag
easier to start from scratch by re-formatting
Windows and required device drivers only
Installing Windows” on page 155).



identical playback computers. 
ing operations on multiple 
ne display computer working 
hers. This, of course, assumes 
ation.

ard disk is to use True Image, 

 to another computer either 

e copies everything on the hard 
OS) or similar upgrade auto-
otherboard upgrades manually 
hip Set Updates” on page 165).
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CLONING A COMPUTER A WATCHOUT system typically uses multiple, 
Performing the above trouble-shooting and tun
computers is tedious. An alternative is to get o
properly, and then clone its hard disk to the ot
that they all have the same hardware configur

A fast and convenient method for cloning the h
from Acronis:

http://www.acronis.com/

Using this program, you can clone a hard disk
across a network or using a CD-ROM. 

▲ IMPORTANT: While the cloning procedur
drive, it does not perform any firmware (BI
matically. You may need to perform any m
after cloning the disk (see “Motherboard C

http://www.acronis.com/
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C.

y technologies, including CRT, DLP 
, video wall cubes and plasma 
y device that’s compatible with the 

ys on adjacent or overlapping 
ir image reproduction. As the light 
jectors may degrade over time, try 

ghly the same number of hours.

 of display technologies, with 
TCHOUT.

 of being able to reproduce a true 
vironment, such as a planetarium, 
t into WATCHOUT. Without a true 
ray banding of the screen in the 

ors and wall cubes may, however, 
by a professional installer in order 
rgence and image uniformity. Their 
bility.
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C DISPLAY ISSUES

WATCHOUT can be used with most displa
and LCD projectors, LCD and CRT monitors
screens. Generally, you can use any displa
display card in the display computer.

Avoid mixing brands and models of displa
areas, since they most likely will differ in the
intensity and color temperature of many pro
to use projectors that have been in use rou

DISPLAY TECHNOLOGIES The following sections provide an overview
special emphasis on aspects related to WA

CRT-based Displays CRT projectors have the unique advantage
black. This is important in a totally dark en
when using the smooth edge-blending buil
black level, it is often impossible to avoid g
overlap areas.

CRT monitors and CRT-based video project
need extensive adjustment and calibration 
to obtain acceptable color matching, conve
analog nature may also affect long-term sta



c mirror chip to modulate the 
technology has the advantage 
ng-term image stability and reli-
puter connection, such as DVI 

 true black. The poor black level 
in gray banding in overlapping 
a totally dark room, and, 
, for example, a shopping mall, 
lem is magnified when using 
 using stronger projectors than 
hting conditions.

me. Modern DLP projectors, 
 Instruments DLP technology, 
tter. 

ith projectors, you get the 
Hence, good contrast and color 
rightness. Hence, choosing a 
n “office grade” projector due 

e level of the former.

el of projector, always perform 
ting conditions. Details vary 
dels, and are not always stated 

ctor may be one of the many 
jectorcentral.com/.
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DLP Projectors DLP (Digital Light Processor) uses a microscopi
light (see http://www.dlp.com/). This display 
of being 100% digital, resulting in excellent, lo
ability – particularly when using a digital com
(see “DVI Connector” on page 173).

An issue with some DLP projectors is the lack of
produced by some DLP projectors often results 
image areas. This is particularly noticeable in 
conversely, is less of an issue in installations at
a trade-show or similar environment. This prob
very bright projectors on a small screen. Avoid
necessary for your screen size and ambient lig

The contrast ratio has greatly improved over ti
utilizing second generation “black chip” Texas
often provide a contrast ratio of 2800:1 or be

Keep in mind that when using WATCHOUT w
combined brightness from multiple projectors. 
saturation is often more important than high b
“home cinema” projector may be better than a
to the better color fidelity and often lower nois

To determine the suitability of a particular mod
proper tests under realistic screen size and ligh
widely among manufacturers and projector mo
on specification sheets. 

A good starting point when looking for a proje
dedicated web sites, such as: http://www.pro

http://www.dlp.com/
http://www.projectorcentral.com/
http://www.projectorcentral.com/
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in many ways similar to DLP projec-
ges and disadvantages. Instead of 
rojector uses an “LCD slide” to 
of this technology means some LCD 
an DLP projectors, and exhibit less 

ck level. The problem is often even 
DLP projectors, and there’s a wider 
f LCD chip manufacturers. Always 

en size and ambient lighting condi-
use in the final presentation. Some 
ors, checkerboards and gradients 
tors (see page 175).

od color matching, brightness and 
g a DVI cable. However, when 
display areas, bear in mind the 

l image quality when viewed from 
you move off-center. Often, the 
ntally than when moving vertically 

le, landscape-oriented, LCD 
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LCD Projectors LCD (Liquid Crystal Display) projectors are 
tors, and share many of the same advanta
bouncing the image off a mirror, an LCD p
modulate the light. The more analog nature 
projectors may require more adjustment th
long-term stability.

Many LCD projectors suffer from a poor bla
more noticeable on LCD projectors than on 
span of variation due to the large number o
make realistic tests under the expected scre
tions. Use images of the kind you intend to 
test images with white, black, saturated col
are often useful too when evaluating projec

LCD Display Panels Modern LCD displays typically have very go
long-term stability – particularly when usin
using multiple LCD displays to build larger 
sometimes limited viewing angle. 

Most LCD displays are designed for optima
the front, with image quality degrading as 
viewing angle is better when moving horizo
(as would be the case when placing multip
displays in a column).



mputer, keep the following in 

e, place the display computer 
e same outlet.

u use high-grade extension 

nalog 15-pin, VGA-style 
er possible, use DVI to connect 
s many of the analog-to-digital 
g VGA-style interface. If 

roducts available from Gefen 
.extron.com/) and others.

s by a common way of inter-
h often referred to as a “VGA 

solution displays, such as XGA. 

 and distribute the signal, using 
As) available from many manu-

o susceptible to hum and noise 
on artefacts. This can result in 
ome of this may be reduced by 
 device and/or display card.
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WIRING When connecting the display to the display co
mind:

• Keep analog (VGA) cables short. If possibl
close to the display, powering both from th

• If you must extend the cable, make sure yo
cables and distribution amplifiers.

Usually, the display is connected by using an a
connector or a digital DVI connector. Whenev
the display computer to the projector. This avoid
conversion problems associated with the analo
required, DVI cables can be extended using p
(http://www.gefen.com/), Extron (http://www

15-pin Mini D-sub Connector The 15-pin mini D-sub connector (page 165) i
facing a computer to a display device. Althoug
connector”, it is also used to connect higher re

Advantages include the ability to easily extend
extension cables and distribution amplifiers (D
facturers. 

Due to the analog nature of the signal, it is als
as well as signal interpretation and digitalizati
pixel jitter and poor or varying color fidelity. S
careful adjustment and tweaking of the display

http://www.gefen.com/
http://www.gefen.com/
http://www.extron.com/
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w.ddwg.org/) connector is 
ideo projectors. As the data to be 
little sense to convert the signal to 
ctor, and then convert it back to 
e DVI connector solves this by 
 the way.

, no pixel jitter and best possible 
rovided with little, or no, need for 
mage consistency and stability.

 difficult to run long cables or to 
ices. Extension nd distribution solu-
bers are available from numerous 
efen.com/).

splay or projector used has a major 
vides additional guidance on deter-
isplay related problems.

t of your display computer to deter-
splay technology or by the display 
you see unwanted phenomena in 
T monitor. If the problem goes 
y or projector, in which case you 
ows up on the CRT monitor as well, 
puter (see “Computer Issues” on 
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DVI Connector The DVI (Digital Visual Interface; http://ww
popular on LCD flat panels as well as DLP v
displayed is digital to begin with, it makes 
analog, pass it through a VGA-style conne
digital form again in the display device. Th
keeping the signal in the digital domain all

The advantages include a rock-solid image
image and color precision. This is usually p
manual adjustment, resulting in improved i

The high speed digital signal makes it more
distribute the signal to multiple display dev
tions based on CAT-5 cables and optical fi
manufacturers (for example, http://www.g

GENERAL TROUBLESHOOTING Just like the display computer, the kind of di
influence on the end result. This section pro
mining the cause and possible remedy of d

Before You Begin Connect a regular CRT monitor to the outpu
mine if the problem is introduced by the di
computer. This is a good advice whenever 
the displayed image – always plug in a CR
away, it’s most likely caused by your displa
should read this appendix. If the problem sh
you should instead focus on the display com
page 155).

Digital Visual Interface 
connector.

http://www.ddwg.org/
http://www.gefen.com/


 move smoothly across the 
ther the display computer or the 
 when you view the output from 
 determined that the jerkiness is 
sing.

ou should preferably use a CRT 
sma screen or projector, since 

ir own. Also, you may want to 
t the CRT display while the dis-
display computer, it may sense 
 change its behavior (for exam-
blem you’re troubleshooting to 

ack of synchronization between 
al operation. This is sometimes 
ch as LCD and DLP. It is not a 
y technologies, since they’re 

equencies, it may work best at 
 setting both the display card 
using video optimized for other 
quency of many projectors and 

l frequency of digital display 
 capable of synchronizing its 

ing video signal. Often, 
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JERKY MOVEMENTS An image moved using a Position track should
displays. Jerky movement may be caused by ei
display device itself. If the problem goes away
the display computer on a CRT display, you’ve
introduced by the display or projector you’re u

▲ IMPORTANT: When making these tests, y
monitor. If possible, avoid LCD monitor, pla
such devices may introduce artefacts of the
unplug the problematic display and connec
play computer is running. If you restart the 
that you’ve plugged in another display and
ple, its refresh rate), thereby causing the pro
change or disappear.

The most common reason for such artefacts is l
the video signal fed to the display and its intern
a problem with digital display technologies, su
problem with most CRT-based computer displa
generally locked to the incoming video signal.

Even if your display device supports multiple fr
one particular frequency. You may want to try
and WATCHOUT to 60 Hz/FPS even if you’re 
framerates, since this is the optimal display fre
other display devices.

It is sometimes difficult to determine the optima
devices, or whether the display device is at all
internal operation to the framerate of the incom
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tes for moves and other effects can 
 may also try connecting the 
 other means, for example using a 

A.

y device can affect the smoothness 
ATCHOUT, it may have a similar 

resentation. This is often particu-
r in objects moving across.

back look considerably smoother, 
ation problems introduced by the 

reas, either within a static image or 

s and gradients, limited resolution 
pear. A good way of testing this is 
he example shown to the left. Such 
ions such as Adobe Illustrator or 
st images with vertical or radial 

 monitor while exhibiting banding 
tion of the display device is insuffi-
ent. Such problems are typically 
ctors. Often, using a digital inter-

ce it circumvents the analog-to-
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changing the programming to use other ra
make artefacts less obvious. If possible, you
display computer to the display device using
digital DVI cable instead of the analog VG

Dropped Video Frames Just as lack of synchronization in the displa
of positioning and other effects created in W
impact on the video material used in your p
larly noticeable in slow zooms and pans, o

If using a CRT display makes the video play
you’re most likely experiencing synchroniz
display or projector (see above).

BANDING This section deals with banding in smooth a
in the overlap area of projected images.

Gradients When displaying images with smooth area
in the display may cause visible bands to ap
to display a smooth grayscale ramp, as in t
an image can easily be created in applicat
Photoshop. You may also want to create te
gradients.

If such test images appear smooth on a CRT
using your display device, the signal resolu
cient to reproduce all the steps in the gradi
associated with low end, office grade proje
face may avoid or solve such problems sin



using the loss of definition (see 

rly near the edges of images – 
e display directly to the 
s has any effect. If so, inserting 
“DA”) may solve the problem. 
 http://www.extron.com/, 
ltinex.com/.

caused by the screen material. 
t projection screens. Such 
ves with you as you walk along 

s to use a different screen mate-
d rear projection are available 

for example, “Aeroview 100” 
ww.stewartfilm.com/).

 overlap areas of edge-blended 
oblems:

 It may be difficult to obtain a 
es. You may have to locate a 
ur presentation and tweak the 
possible result (see “Edge Blend 

 and DLP projectors have a 
tandard curves to choose from. 
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digital conversion step, which is most likely ca
“DVI Connector” on page 173).

Another possible cause for banding – particula
is long or faulty VGA cables. Try connecting th
computer using a short VGA cable to see if thi
a VGA distribution amplifier (often called just 
Such devices are available from, for example,
http://www.inlineinc.com/ and http://www.a

Rear Projection When using rear projection, banding may be 
This may also occur when using high-gain fron
banding can be identified by the fact that it mo
the screen.

The only way to avoid or solve such problems i
rial. Suitable low-gain screens for both front an
from most professional screen manufacturers (
from Stewart Filmscreen Corporation; http://w

Edge Blend Areas Banding and other artefacts may appear in the
images. There are essentially three kinds of pr

Too Dark, Bright or Uneven Overlap.
perfectly invisible edge blend for all image typ
typical or particularly problematic image in yo
edge blend curve using that image for the best 
Curve” on page 109).

Non-linear Gamma Settings. Most LCD
gamma curve setting, often with a number of s

http://www.extron.com/
http://www.inline.com/
http://www.altinex.com/
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htness, such projectors often come 
e. While such a gamma curve may 
linear nature tends to interfere with 
. Furthermore, it also results in 
trast. To avoid this problem, chose 

Photographic” or “Video”.

horizontal strips of varying black 
0% white in 10% increments) often 

ear gamma setting.

 the poor contrast ratio of some 
s in the overlaps of black, or very 
 can minimize the effect by 
if possible), or by increasing the 
er, the best solution is to avoid 
n altogether.

 edge-blend area is often the result 
ojector. Create a test image with a 
 past the edge blend layer in 
ven in the edge blend areas (see 
. Adjust the projector so that the 
e horizontal position of the image 

sappears, then move it back so they 
ake the right edge of the image fit 
 repeat the position and width 
ing one may affect the other.
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In order to achieve maximum perceived brig
preset to some high brightness gamma curv
provide some additional brightness, its non-
the ability to achieve a smooth edge blend
washed-out colors and a general lack of con
a more linear gamma curve, often called “

Projecting a gray ramp, or an image with 
level (for example, eleven strips from 0 to 10
reveals problems associated with a non-lin

Gray Boxes in Dark Images. Due to
LCD and DLP based projectors, lighter area
dark images are sometimes inevitable. You
reducing the light output of the projectors (
ambient lighting in the room. Often, howev
black or large dark areas in the presentatio

Thin, Dark or Bright Slivers A slightly darker or brighter sliver along the
of under or over-shooting the chip in the pr
one or two pixel white edge. Put this image
WATCHOUT, so you can see all its pixels e
“No Edge-blend Past Layer” on page 109)
image exactly fills the image area. Move th
to the left so the leftmost row of pixels just di
reappear. Now adjust the image width to m
the image area precisely. You may have to
adjustments a couple of times, since chang



ge shows the top and bottom 
r the image height, but if there 

n, available in most projectors. 
age on the chip and will likely 
f the overlap areas.

ter of front or rear-projected 
bright areas tend to move with 
y way to solve such problems is 
ain screens for both front and 
ional screen manufacturers (see 

ee shades or ridges creeping 
rtefacts are somewhat reminis-
lide projectors. They are gener-

description under “Banding” on 

se a set of test images with hori-
h an image slowly and look for 
e same test with a CRT display. 
tlined above under “Banding” 
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Also ensure that the vertical position of the ima
row of pixels. There’s usually no adjustment fo
is, you may want to check that also.

Avoid all forms of electronic keystone correctio
Such a feature deliberately undershoots the im
cause dark slivers to appear along the edges o

HOT-SPOTS Hot-spots appear as bright areas near the cen
images. As you move across the screen, these 
you in relation to the projected image. The onl
to use another screen material. Suitable low-g
rear projection are available from most profess
“Rear Projection” on page 176).

CREEPING SHADES When fading an image, you may sometimes s
across or around smooth image areas. These a
cent of the Newton rings sometimes seen with s
ally caused by lack of resolution, similar to the 
page 175.

The best way to diagnose these problems is to u
zontal, vertical and radial gradients. Fade suc
bands or rings moving across the image. Run th
The solution for this problem is the same as ou
on page 175.
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s, optical linearity is important. 
rel or pin-cushion distortion. This 
g short-throw, wide angle lenses 

oose projectors with high-grade 
roperly matched for the desired 

ay be able to obtain better linearity 
g the projector accordingly.

ature built into WATCHOUT 
. Some projectors have similar 
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OPTICAL LINEARITY When using multiple overlapping projector
Deficiencies in optics often show up as bar
may be particularly troublesome when usin
(often desirable for rear-projection).

The best way to avoid this problem is to ch
optics, and to ensure that your optics are p
projection distance. 

◆ HINT: If you’re using zoom lenses, you m
by changing the focal length and movin

Correcting Optical Errors If necessary, use the geometry correction fe
(page 136) to compensate for the distortion
capabilities built in.

Pin-cushion and barrel distortion.
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COL D.

 computer from an external device, 
nel (shown to the left), or any other 
ing using the TCP/IP protocol.

lities and commands, this protocol 
r “Display Cluster Protocol” on 
ontrol the production computer, 
ls one or many display clusters, 
ter.

ncludes commands allowing you to

.

e in this way, you must choose 
 box (see “External Control” on 

 application provides a graphical 
 WATCHOUT. This can be used as 
truct and send commands to 
EMAKER Handbook” for details.
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D PRODUCTION PC PROTO

You can control a WATCHOUT production
such as Dataton’s TOUCHDOWN touch pa
device or software capable of communicat

◆ NOTE: While similar in its basic capabi
is different from the one described unde
page 185. This protocol allows you to c
while the Display Cluster Protocol contro
with no need for any production compu

The production computer control protocol i

• Load a show from a specified file.

• Start, stop, position and run the timeline

• Access the standby mode.

To control WATCHOUT production softwar
“TCP/IP Network” in the Preferences dialog
page 108).

◆ HINT: The TOUCHDOWN GuideMaker
user interface for sending commands to
a way to learn more about how to cons
WATCHOUT. Please refer to the “GUID



ber 3040 of the WATCHOUT 
ent as a string, terminated by a 

etimes followed by parameters. 
ODE character format, which is 

SCII characters – such as å, ä, 
mat.

s. Backslash is used as an 
uote in a string, precede it with 
se “\\” inside the string.

formed commands are not 

, an error response is returned:

g>\n

ode number, the second para-
ssage, and the third parameter 
 quoted string.
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Command Format To control WATCHOUT, open TCP/IP port num
production computer. Each command is then s
carriage return, line feed or CR/LF pair.

A command consists of a command name, som
Commands are encoded using the UTF-8 UNIC
downward compatible with ASCII strings.

▲ IMPORTANT: Commands containing non-A
ü, ç – must be encoded using the UTF-8 for

String parameters are sent within double quote
escape character (that is, to encode a double q
a backslash). To send a backslash character, u

Commands are case sensitive. Successfully per
acknowledged.

Errors If an error occurs while processing a command

Error <uint> <string> <strin

where the first parameter is an internal error c
meter is a quoted string containing the error me
is a copy of the offending command, also as a
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ands, with some commands 
ages.

, specified in milliseconds:

econds).

error if the cue can’t be found. The 
d is case sensitive.

rameter is true or false (without 

n.

n milliseconds.

e is case sensitive).

alse.

with optional layer conditions.
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LIST OF COMMANDS The table below shows the available comm
explained in more detail on the following p

gotoTime Jumps to a time position along the timeline

gotoTime 60000

goes to one minute (60000 / 1000 = 60 s

gotoControlCue Jumps to a named Control cue. Returns an 
name is specified within double quotes, an

gotoControlCue “anders”

standBy Enters or exits standby mode, where the pa
quotes).

standBy true

Command Parameters Description

run Run timeline from current positio

halt Stop at the current position.

gotoTime <uint> Go to a time position, specified i

gotoControlCue <string> Go to a named Control cue (nam

standBy <bool> Set the standby mode to true or f

load <string> [<uint>] Load a show from specified file, 



s a quoted string containing the 
cters in Windows path names 
ape character in this protocol. 
 forward slashes instead (as 

.watch”

 production software will auto-

o override the conditional layer 
e, to enable condition 1 and 2 

.watch” 3

bers corresponding to each 
 left.
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load Loads a show by name. The name is specified a
full path to the file. The use of backslash chara
conflict with the use of the backslash as an esc
Either double the backslash characters, or use
shown in this example):

load “C:/Samples/ExampleShow

◆ NOTE: When using this load command, the
matically go online after loading the show.

If desired, you can add a numeric parameter t
settings of the show being loaded. For exampl
only:

load “C:/Samples/ExampleShow

Where the number is a sum of the decimal num
desired condition, as shown in the table to the

Condition Number to Add

1 1

2 2

3 4

4 8

5 16

6 32

…and so on.
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COL E.

isplay computers using a local 
device capable of communicating 

omputer protocol described in the 
you to control WATCHOUT display 
being present in the system.

re that the show has been success-
ware (meaning that all media files 

ATCHOUT production software.

ing a file stored on the primary 
mmands sent via the network or 

splay computer’s hard disk to auto-
rotocol when starting the display 
 set up a system that automatically 
uter is switched on.

ext editor or word processor 
 those commands when starting the 
 the name of this command file as 
oftware. If started using a shortcut 
Appendix E     Display Cluster Protocol

E DISPLAY CLUSTER PROTO

Overview You can control a cluster of WATCHOUT d
command file or from a computer or other 
using the TCP/IP protocol. 

◆ NOTE: While similar to the production c
previous appendix, this protocol allows 
clusters without a production computer 

Preparation Before attempting to control a cluster, ensu
fully run from WATCHOUT production soft
have been transferred, etc). Then quit the W

CONTROL OPTIONS You can control the display cluster either us
display computer in the cluster, or using co
through a serial port.

File-based Control You can use a file stored on the primary di
matically perform most commands in this p
software. This can, for example, be used to
loads and runs a show every time the comp

The command file can be created using a t
capable of saving as plain text. To perform
WATCHOUT display software, you provide
a command line parameter to the display s



e name of the command file to 

mand file that displays a 
w seconds, loads a show, waits 
186 Appendix E     Display Cluster Protocol

(possibly located in the Startup folder), add th
the Target field of the shortcut.

The example below shows the content of a com
message on the WATCHOUT screen, waits a fe

Enter the name of the command 
file here. This example assumes 
that the file is stored in the folder 
where WATCHOUT is installed.

Make sure this is set to the folder 
where WATCHOUT is installed.
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T display cluster to become ready, 

ill begin shortly”

appendix for details.

ers in the show name (for example; 
 to save the text using the UTF-8 
 usually easiest to rename the show 

uting commands from a such a 
e window. However, to see this 
ATCHOUT display window by 
ur command file doesn’t work as 

a the network, connect to TCP/IP 
T display computers. The computer 

he master of the cluster, and will 
bers, as specified by the presenta-
Appendix E     Display Cluster Protocol

for any other computers in the WATCHOU
and then runs the show.

authenticate 1
setLogoString “The show w
delay 5000
load “MyShow”
wait
run

See each individual command later in this 

▲ IMPORTANT: If using non-ASCII charact
å, ö, ü, ß), your text editor must be able
encoding. If you’re unsure about this, it’s
to avoid non-ASCII characters.

◆ NOTE: Any errors occurring while exec
command file are displayed in a consol
window, you have to close the main W
pressing Ctrl-W. Keep this in mind if yo
expected.

Network Control To control a WATCHOUT display cluster vi
port number 3039 of one of the WATCHOU
you initiate communication with becomes t
automatically control the other cluster mem
tion loaded using the “load” command.



tion. Open the port specified 
TCHOUT will respond with a 
 some other details.

 a serial port, connect the 
 WATCHOUT display 
es the master of the cluster, and 
bers, as specified by the presen-

lPort command to open a serial 
the file-based control feature to 
ed Control” on page 185).

ommands. Some commands 
d of response to the controller. 

xception of the “ping” 
 level. To control WATCHOUT, 

. You can now send other 

y a carriage return, line feed or 
d name, sometimes followed by 
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Use a Telnet program to check the communica
above, then type “ping” and press Return. WA
Ready message, stating its version number and

Serial Control To control WATCHOUT display cluster through
controlling device to a serial port of one of the
computers. The computer you connect to becom
will automatically control the other cluster mem
tation loaded using the “load” command.

No serial port is open by default. Use the seria
port. Put this command into a text file, and use 
perform the serialPort command (see “File-bas

COMMANDS AND RESPONSES WATCHOUT uses a simple text format for its c
may return a reply, error message or other kin
Such responses are also sent as text.

Authentication Before you can give any command (with the e
command), you must specify the authentication
you need authentication level 1:

authenticate 1

WATCHOUT responds with a Ready message
commands.

Command Format Each command is sent as a string, terminated b
CR/LF pair. A command consists of a comman
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 Commands are encoded using the 
 downward compatible with ASCII.

 containing non-ASCII characters – 
ed using the UTF-8 format.

essful. You can explicitly request 
bed under “Command ID Tagging” 

eters are separated by white-
n in square brackets, like this: 
d below.

uotes.

hat is, to encode a double quote in 
nd a backslash character, use “\\” 

nce of decimal digits.

equence of decimal digits, optio-
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parameters. Commands are case sensitive.
UTF-8 UNICODE character format, which is

▲ IMPORTANT: When sending commands
such as å, ä, ü, ç – these must be encod

Responses and Feedback Most commands perform silently when succ
acknowledge from any command as descri
on page 201.

Parameters For commands that take parameters, param
space only. Optional parameters are show
[<uint>]. The parameter types are describe

<string> String parameters are sent within double q

“This is a string”

Backslash is used as an escape character (t
a string, precede it with a backslash). To se
inside the string.

<uint> An unsigned integer, expressed as a seque

123

<int> A signed decimal integer, expressed as a s
nally preceded by a minus sign.

-123

<bool> The keyword true or false, with no quotes.

true



s, with some commands 
 brackets.

ack message to be sent.

er commands [188].

 cue [192].

ning show [193].

go on screen [192].

and file use only) [194].

 established [194].

pecifying its parameters [194].

U) timecode control [195].
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LIST OF COMMANDS The table below shows the available command
explained further on the page indicated within

Command Description

ping Do-nothing command causing a Ready feedb

authenticate Perform authentication. Required prior to oth

load Load a show and get ready to run [191].

run Start running.

halt Stop running.

gotoTime Jump to a time position [191].

gotoControlCue Jump to the time position of a named Control

enableLayerCond Turn conditional layers on or off [192].

standBy Enter/exit standby mode [192].

getStatus Retrieves name and status of the currently run

setLogoString Display some text next to the WATCHOUT lo

delay Introduces a delay between commands (comm

wait Waits for the entire display cluster to become

serialPort Opens a serial port for control protocol use, s

timecodeMode Activates the LINE IN port for LTC (SMPTE/EB
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 local file associated with the show 
 feedback may be sent to the host 
 progress (see “Busy” on page 
(see “Error” on page 198). Finally, 
ess of whether any error occurred 

h to the show. The show must be 
n the same folder as the 

e timeline.

faults to true.

. Defaults to true.

ficant bit is condition 1.

as a string in this format: 
ds.
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load Load a complete show specification from a
name specified by the first parameter. Busy
while loading, informing the host about the
197). If errors occur, Error feedback is sent 
a Ready feedback message is sent, regardl
(see “Ready” on page 196).

load “Phantom”

◆ NOTE: You can not specify a folder pat
present in the “Shows” folder, located i
WATCHOUT display software.

gotoTime Jump to the specified time position along th

gotoTime 5000

Parameter Description

<string> Name of the show to be loaded.

[<bool>] Manage cluster loading and feedback. De

[<bool>] Designate as the master display computer

[<uint>] Conditional layer enable flags, least signi

Parameter Description

<uint> or <string> Time position to go to, in milliseconds, or 
“HH:MM:SS.FFF”, where FFF is millisecon



optional “reverse only” boolean 
ly back in time from the current 
rd then reverse. 

f the timeline. If specified cue is 
and a runtime error message to 

e

hile the layer conditions can be 
parate command allows the 
g another show. The command 
th the same interpretation as the 
and (see page 191).

HOUT logo, when shown on 

ay and sound is muted, or 
d (see “Perform Normal/In 
red/exited smoothly, by speci-

ecified, then search both ways.
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gotoControlCue Jump to the time of specified Control cue. If the 
is set to true, it searches for the Control cue on
time position. Otherwise it searches first forwa

The command does not change the run mode o
not found, the timeline’s state will not change, 
this effect will be returned.

gotoControlCue “William” tru

enableLayerCond Change the set of enabled layer conditions. W
specified as part of the load command, this se
layer conditions to be changed without loadin
takes a single, mandatory <uint> parameter wi
conditional layers parameter of the load comm

setLogoString Display the string parameter next to the WATC
screen. See example on page 187.

standBy Enter/exit standby mode. In standby, the displ
media on standby layers – if any – is performe
Standby” on page 92). This mode can be ente
fying a fade rate.

standBy true 1000

Parameter Description

<string> Name of Control cue to look for.

[<bool>] Search in reverse only if true. If false or not sp
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d and enter standby mode. If any 
ormed instead.

luster master. 

true true false 122 true

arameters:

o if not specified.

w loaded.

or any of its slaves is busy 

, 1: Suboptimal, 2: Problems, 3: 

y included if show is active).

luded if show is active).
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Fade out sound and image over one secon
standby layer is available, its media is perf

getStatus Get the current status of the WATCHOUT c

getStatus
Reply “WO2Launch” false 0 

Responds with a Reply with the following p

Parameter Description

<bool> Enter standby if true, exit if false.

[<uint>] Fade rate, in milliseconds. Defaults to zer

Reply Parameter Description

<string> Name of the show. Empty string if no sho

<bool> Busy. True if the master display computer 

<uint> General health status of the cluster; 0: OK
Dead.

<bool> Display is open (in its full screen mode).

<bool> Show is active (ready to run).

<bool> Programmer is on line.

[<uint>] Current time position, in milliseconds (onl

[<bool>] Show is playing – false if paused (only inc



e parameter before performing 
page 187. 

mand file.

blished before proceeding with 
e number of milliseconds speci-
87. 

mand file.

e, setting its parameters.

Port command into a text file, 
rform the commands in this file 

.

is none.
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delay Wait the number of milliseconds specified by th
the next command in the file. See example on 

◆ NOTE: Performed only when used in a com

wait Wait for the display cluster to become fully esta
the next command in the file. Waits at most th
fied by the parameter. See example on page 1

◆ NOTE: Performed only when used in a com

serialPort Open serial port for cluster control protocol us

serialPort true “COM1”

◆ HINT: For serial-only control, put the serial
and use the file based control feature to pe
(see “File-based Control” on page 185).

Parameter Description

<bool> Open (true) or close (false) the serial port.

<string> The name of the serial port.

[<uint>] Protocol selector. Must be 0. Default is 0.

[<uint>] Data rate, in bits per second. Default is 9600

[<uint>] Number of data bits, 7 or 8. Default is 8.

[<uint>] Number of stop bits, 1 or 2. Default is 1.

[<uint>] Parity: 0 = none, 1 = odd, 2 = even. Default 
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he timecode receiver is initially off. 
ntrol the presentation as if using the 
more, while playing, the presenta-

e whenever possible. Instead, 
plicitly. Specifically, the SMPTE 30 
tomatically.

on to verify proper timecode recep-
onnector to use for the timecode 
).

de control feature, put this 
nder “File-based Control” on 

 = EBU 25 fps, 3 = SMPTE 29.97 
0 (”B&W”).

s a string in this format: 
ds. Default is 0.
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timecodeMode Controls the built-in LTC timecode receiver. T
When turned on, incoming timecode will co
run, halt and gotoTime commands. Further
tion will be synchronized to the timecode.

timecodeMode 2 ”-1:00:00”

◆ NOTE: Avoid using the auto-detect mod
specify the expected timecode format ex
(”B&W”) format can not be detected au

Use the separate Timecode Tester applicati
tion, and to choose the appropriate input c
signal (see “Timecode Control” on page 86

◆ HINT: For stand-alone use of the timeco
command into a text file, as described u
page 185.

Parameter Description

<uint> 0 = receiver off, 1 = auto-detect format, 2
NDF, 4 = SMPTE 29.97 DF, 5 = SMPTE 3

[<int> or <string>] Time offset expressed in milliseconds, or a
“HH:MM:SS.FFF”, where FFF is millisecon



k messages to the controller. 
eive such messages at any time 
mmands.

or occurs. Use the command ID 
ively acknowledged, if desired 
hen using command ID 

ct response to a command will 
nt to the sender of that 

ot directly associated with a 
ecently connected or authenti-

sy (as indicated by one or more 
ping” command. 

ndows” true

ginating from the master).
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FEEDBACK The WATCHOUT cluster master sends feedbac
Note that the controller must be prepared to rec
– not only as a direct response to particular co

Most commands execute silently, unless an err
tagging feature to force commands to be posit
(see “Command ID Tagging” on page 201). W
tagging, any feedback message sent as a dire
be tagged by that command ID, and will be se
command.

Any spontaneous feedback message (that is, n
particular command) will be sent to the most r
cated controller.

Ready Sent once when becomes ready after being bu
Busy messages). Also sent as response to the “

Ready “2.0” “WATCHPOINT” “Wi

Feedback Parameter Description

<string> The version of the program.

<string> The name of the program.

<string> The name of the computer/OS.

<bool> License key is up to date.

[<string>] Address of originator (empty or omitted if ori
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asks, such as downloading or 

a/Wilfred.jpg” 76

ay be empty, in which case the 
 for these parameters and just 

erring”). May be empty string.

ce, a file name). May be empty.

 originating from the master).
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Busy Sent repeatedly while busy doing lengthy t
caching files.

Busy “Transferring” “Medi

Note that either or both string parameters m
controller should retain the previous values
update the progress value.

Feedback Parameter Description

<string> What is being done (for instance, “Transf

<string> The subject of the above action (for instan

<uint> Percentage done so far, 0...100

[<string>] Address of originator (empty or omitted if



esult of a command, or for any 

 the host’s OS. Under 
re, with the error code included 
o an error message string). The 
ation.

inating from QuickTime. This is 
 QT errors use MacOS style 
 error typically originates from 
 opened or played. The third 
offending media file.

Win32 HRESULT).

und during download).
 loading a specification file).
ring.

ero.

ginating from the master).
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Error Sent when any error occurs, either as a direct r
other reason.

Operating System Error Indicates a generic operating system error from
Windows, this is a HRESULT that indicates failu
as the second parameter (possibly decoded int
third parameter may provide additional inform

QuickTime Error Similar to the Operating System Error, but orig
treated separately from the OS errors since the
error codes even under Windows. This kind of
still image files, or from video files as they are
parameter generally contains the name of the 

Feedback Parameter Description

<uint> Error kind:

1 Operating system error (for instance, a 
2 QuickTime error (Mac OSErr style).
3 Rendering API error (that is, DirectX).
4 Network errors (that is, WinSock).
5 File server error (for example, file not fo
6 Syntax/parser error (for instance, when
7 General runtime error – described by st
8 Authentication error.

<int> or <string> Error number or description string. May be z

<string> Excuse or explanation, may be empty string.

[<string>] Address of originator (empty or omitted if ori
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ring. This is similar to other oper-
w that it occurred while rendering. 
isplay card driver issues, video 

tions.

rk communication. This is similar to 
ou also know that it occurred 
mes, network errors are caused by 
s, the computer’s network configu-
r instance, a bad cable/hub or 

e from the media file server. The 
e first Reply parameter in the File 

ly the name of the required file.

ng structured data (such as a show 
ry with the nature of the error. 

ve cases. Always described further 
ll as further information in the third 
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Rendering API Error Error occurred specifically related to rende
ating system errors, except that you also kno
Sometimes, rendering errors occur due to d
memory or other hardware resource limita

Network Error Error occurred specifically related to netwo
other operating system errors, except that y
specifically while using the network. Someti
network interface hardware or driver issue
ration, or problems on the network itself (fo
incorrectly configured router).

File Server Error Error occurred when attempting to get a fil
error number the same as those listed for th
Transfer group. The Excuse string is typical

Syntax/Parser Error Indicates an error that occurred when readi
specification file). Error code and excuse va

General Runtime Error Other errors, not covered by any of the abo
by a string as the second parameter, as we
parameter (optional).



ntext information. For instance, 
r, it may provide information to 

 Video 960 KB“

 this command.

nse sequence failed.

 for port.

only mode.

ginating from the master).
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Authentication Error The second parameter gives further details:

The third parameter may provide additional co
in the case of being in use by another controlle
identify that controller – such as its address.

Warning Sent when a non-critical error occurs.

Warning “Low Memory: Primary

Value Description

1 You have no authority.

2 Your authority is insufficient for

3 In use by another Programmer.

4 Authentication challenge/respo

5 Invalid authentication level.

6 Authentication level not allowed

7 Command not allowed in read-

Feedback Parameter Description

<string> The warning message, as a quoted string.

[<string>] Address of originator (empty or omitted if ori
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ct response to a query command 
193). Use a command ID to posi-
.

s on the command that caused the 

either due to a keyboard or other 
rs.

 a command ID. This is any 
brackets. When used, at least one 
and. The reply is then also tagged 

NT” “Windows” true

ation of commands, or to explicitly 
and.

ing.

 originating from the master).
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Information Sent to convey some general information.

Reply A Reply feedback message is sent as a dire
(for instance, getStatus described on page 
tively associate the reply with the command

The format of the reply parameter(s) depend
reply to be sent.

Quit Sent when the application is about to quit (
command). This message has no paramete

COMMAND ID TAGGING Commands may optionally be preceded by
sequence of characters enclosed in square 
explicit reply is always sent for each comm
with the same ID:

[23]ping
[23]Ready “2.0” “WATCHPOI

Use this feature if you want positive confirm
associate a feedback message with a comm

Feedback Parameter Description

<string> The information message, as a quoted str

[<string>] Address of originator (empty or omitted if
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eview of 118
d 105

38

 70, 140

, 141
145

lifier) 35
Index

INDEX

A
acceleration 79
adding a control cue 130
adding a display 116
adding a media proxy 120
Adobe After Effects 53
alpha channel 49, 54, 122
anchor point 77
anchor point, in images 108
anti-aliasing 51
audio see sound
Autodesk Cleaner 53
AVI 51

B
Background Color command 116
base framerate 107
batch file 185
Best Quality command 117

C
cache folder 82
CachedFiles 82
Clear command 112
cluster control protocol 185

codec 54
command file 185
conditional layers, pr
Consolidate comman
control cue 130
Copy command 112
cue 12, 68, 137

adding 91, 137
control 130
cutting 138
deleting 138
duration 71, 139
media position 1
pasting 138
pause 72
positioning 137
replacing media
selecting 137
specifications 71
tween track 73, 

curved screen 136
Cut command 112

D
DA (distribution amp
deinterlace

live video 126



mand 115
 114
 128

 83
204 Index

display 133
adding 63, 89, 116, 133
address 134
address prefix, in preferences 107
arranging 63
duplicating 133
DVI 173
geometry 136
installing 33
LCD 171
name 134
online 118
positioning 133
removing 133
selecting 133
specifications 134
stage position 135

display computer 9
connecting to 81
quitting WATCHOUT 81

distribution amplifier 172
DLP projector 170
DV 51
DV video format 55
DVI connector 173

E
EBU timecode 86
edge-blend, disabling for layers 109

edit menu 112
Ethernet 32
external control 85

F
file menu 103
find and replace 114
Find command 151
Find/Replace Again com
Find/Replace command
folder, in media window
framerate 107
free running 143
function keys 151

G
geometry correction 136

H
high definition video 51
hub 32

I
in-time 143
IP address 42

J
jump button 91
jumping, in presentation
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ociation 66, 95
 files 114
s 82
e 89
6

 96
38

20
66
6, 129

 129
Index

L
layer 70

changing height 92
collapse 90
condition 93
current 91
deleting 130
disabling preview of 92
inserting 130
renaming 130
selecting 91
settings 92, 130

LCD display 171
LCD projector 171
license key 32
live video 125, 126
live video input 34
loop 143
looping 83, 150

M
Masked by Displays command 117

media 12, 65
adding 65, 94
changing file ass
changing path to
downloading file
dragging to stag
editing file 66, 9
locating file 95
opening original
positioning 89, 1
proxy 67, 96, 1
purging unused 
refreshing 66, 9
removing 95
selecting unused
window 94

menu
edit 112
file 103
media 120
stage 116
timeline 130
tween 132

message 97
removing 97

MOV file format 51
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h 79, 80

3

s 56
nd 117
 116
 command 118
206 Index

movie 51
assembling individual frames 53
audio embedded in 60
computer generated 52
pre-splitting 56, 121

moving along a path 148
MPEG 51
MPEG-1 54
MPEG-2 55

N
Network 187
network 9

connecting 32
control 181, 185
requirements 154

network control 187
New Folder command 128

O
online 81
Online command 118
opacity 49, 54, 76
opacity tweening 146
Open command 104
optical distortion 136, 179
Outline Dimmed Images command 117

P
Paste command 112
pause cue 72
perspective correction 1
play 91
PNG image files 55
position

animating 78
editing 78
moving along a pat
tweening of 148

preferences 107
pre-roll 142
presentation

controlling 85
looping 83
making new 103
manual control of 8
opening 104
saving 104

pre-splitting large movie
Preview Options comma
Preview Scale command
Preview Stand-By Layers
production computer 8

control protocol 181
progressive video 51
projection screen 33
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, 59

nd 113

89
9
r 116

mages 117
ays 135
a preview 69, 89

17, 143
9
w 117

, 89

der 92

 185
Index

projector
DLP 170
LCD 171

protocol 181, 185
proxy 67, 96, 120

Q
QuickFind 151
QuickTime

file formats 48
installing 31
obtaining 31

R
Refresh Media command 96, 129
remote computer 123
rotation tweening 149

S
Save a Copy command 104
Save command 104
scale tweening 147
scaling 76
Select All command 112
Select to End command 112
Select Unused command 129
serial control 85, 108, 188
SMPTE 86

sound
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text, using in presentation 50
Thumbnails command 117
time scale, adjusting 90
timecode 86, 195
timeline 12, 68

adding cues to 68, 91
jump button 91
layer 70
playing 91
settings 131
starting 91
window 90

timeline menu 130
Timeline Settings command 131
transparency

pre-multiplied, straight 122
transparency see opacity
triangle, in layer header 90
tween menu 132
tween point 74

copying 74
corner 74
editing numerically 75
removing 74
smooth 74

tween track 12, 73, 145
adding points to 74
opacity 76
position 78
rotation 77
scale 76
stretching 74
volume 76

U
Undo command 112
Update command 119
USB port 32

V
velocity 79
VGA connector 165, 17
Video as Thumbnails co
video distribution amplif
video see movie
VNC 123
volume 76
volume tweening 146

W
warping 136
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